~ caseware

Beschreibungsstandard
fur die Datentrager-
uberlassung

Erlauterungen zur Speicherung und Beschreibung
von Daten im Rahmen der GDPdU/GoBD

Version 1.6




~ caseware

Copyright

CaseWare Germany GmbH
Meitnerstr. 6

70563 Stuttgart
Deutschland

Bei der Abfassung dieses Leitfadens wurde mit gréBtmdglicher Sorgfalt und Gewissenhaftig-
keit vorgegangen. Fur Auslassungen oder Fehler konnen weder der Autor noch die CaseWare
Germany GmbH eine Haftung oder juristische Verantwortung tbernehmen.

Dieser Leitfaden ist urheberrechtlich geschutzt. Die dadurch begrindeten Rechte, insbeson-
dere die der Ubersetzung, des Nachdrucks, der Entnahme von Abbildungen und Tabellen oder
die Vervielfaltigung auf anderen Wegen, bleiben, auch bei nur auszugsweiser Verwertung,
vorbehalten. Weitergabe und Vervielfaltigung dieser Publikation oder von Teilen daraus sind
ohne die ausdruckliche schriftiche Genehmigung durch die CaseWare Germany GmbH nicht
gestattet.

Aus Grunden der Lesbarkeit verwenden wir in unseren Texten die mannliche Sprachform. Dies
bedeutet jedoch keine Benachteiligung des weiblichen/dritten Geschlechts, sondern soll im

Sinne der sprachlichen Vereinfachung als geschlechtsneutral zu verstehen sein.

IDEA ist ein eingetragenes Warenzeichen von CaseWare International Inc.



caseware

Beschreibungsstandard-Version 1.6 vom 1. Marz 2019

Anderung Datum Autor(en)
Beschreibungsstandard-Version 1.0 06.06.2002 | Jon Chick
Beschreibungsstandard-Version 1.1 01.08.2002 | Jon Chick
Beschreibungsstandard-Version 1.2 01.06.2003 | Jon Chick
Beschreibungsstandard-Version 1.3 01.11.2003 | Jon Chick
Beschreibungsstandard-Version 1.4 01.05.2004 | Jon Chick
Beschreibungsstandard-Version 1.5 01.10.2004 | Jon Chick
Beschreibungsstandard-Version 1.6 01.03.2019 | Radu Furcea
Tabelle 1: Anderungshistorie Beschreibungsstandard
Dokument-Version 1.6 vom 1. Marz 2019
Anderung Datum Autor(en)
Dokument-Version 1.0 06.06.2002 Jon Chick, Tankred Giese,
Martin Otto
Dokument-Version 1.1 01.08.2002 Martin Otto, Jon Chick,
Erlauterungen zu References Tankred Giese, Michael
Erweiterungen Version 1.1 Schleupen
Dokument-Version 1.2 01.06.2003 Martin Otto, Jon Chick,
Erlauterungen zu Alias Tankred Giese, Michael
Erweiterungen Version 1.2 Schleupen
Dokument-Version 1.3 01.11.2003 Martin Otto, Jon Chick,
Erlauterungen zu Extension Tankred Giese, Michael
Erweiterungen Version 1.3 Schleupen
Dokument-Version 1.4 01.05.2004 Martin Otto, Jon Chick,
Erlduterungen zu AcceptNoTables Tankred Giese, Michael
Erweiterungen Version 1.4 Schleupen
Dokument-Version 1.5 01.10.2004 Martin Otto, Jon Chick,
Erlduterungen zu mehreren Alias- Tankred Giese, Michael
Elementen Schleupen
Erweiterungen Version 1.5
Dokument-Version 1.6 01.03.2019 Radu Furcea, Tankred

Erlauterungen zum Datentyp Zeit
Erweiterungen Version 1.6

Giese, Michael Schleupen

Tabelle 2: Anderungshistorie Dokument




caseware

Inhalt
Adressaten diESES PapI€rsS.........ciiiiiii i aaan 5
ZusammeENnfasSUNG/ZIEI .........ooouiiiiiiiiiiiieeeeee ettt 5
Text VON § 147 ADS. 6 AD ...ttt 6
DatentragerUberlasSUNQ .........oouuui oo e e e e e e e e 6
Die Datenorganisation bei der Datentrageriberlassung............ccccvvviiiiiiiiiiiiiiiiiiiiiiiiiieeee, 8
Die Rolle des Softwareherstellers ... 9
XML-basierter Beschreibungsstandard.............ccouiiiiiiiii e 10
Y=Y o] 1o RSN 10
Allgemeine Annahmen bzw. Voraussetzungen zur DTD ..., 10
Technischer Ablauf des IMPOrtProOZESSES ......ccocciiiiiiiiiiiee e 11
DiHE XML-DTD ..ttt ettt e e ettt e e e e e e e e e e e e e e e e 12
Organisation des Beschreibungsstandards..................oooiiiiiiiiiiiiiiiiiiiiiiiiiiiiieeeeeeeeeee 17
HINWEISE ZU XML ...t e e et ettt e e e e e e e e e et a e e e e e e e eeeeeaasaanns 21
Beschreibung der Elemente....... ..o e 22
Beispiel 1 fir eine Datei iNdeX. XMl .......ccoooiiiiiiiii e 40
Beispiel 2 fUr VerknUpfungen ... 43
Beispiel 3 fur eine Datei index.xml (komprimierte Daten) ...........cccccceeiiiniiiiiiee 46
Beispiel 4 fur eine Datei index.xml (Datentyp Zeit)...........ccoooiiiiiiiiiiiiiiieeeeeees 47
Haufig gestellte Fragen ... 50
Synopse Beschreibungsstandard Version 1.0 und Version 1.1..........ccoviiiiiiiiiiiiiciccee e, 53
Synopse Beschreibungsstandard Version 1.1 und Version 1.6.............ccccoooeeiiiiie. 59
ADDIAUNGSVEIZEICNNIS ...t 69
TabelleNVErZEICNNIS .......ciiiieeeeeeeeeeeeeeeee ettt e e eeees 70

Beschreibungsstandard GDPdU/GoBD 4



caseware

Adressaten dieses Papiers

¢ Anwender von Software, die zur Bereitstellung eines Datentragers/Datenpakets nach
GDPdU/GoBD aufgefordert werden.

e Entwickler von Software, die steuerrelevante Daten fir die Datentrageriberlassung nach
GDPdU/GoBD bereitstellen.

Zusammenfassung/Ziel

Nach § 147 Abs. 6 AO ist es der Finanzverwaltung maoglich, die Daten von elektronischen
Buchfuihrungssystemen ,digital“ zu prifen, entweder durch Datentragertiberlassung und/oder
durch mittelbaren bzw. unmittelbaren Zugriff.

Fur die Datentragertberlassung ist es notwendig, dass die Daten von dem steuerpflichtigen
Unternehmen (oder dem beauftragten Steuerberater, buchfihrenden [Sub-]JUnternehmen
etc.) in ,maschinell auswertbarer Form* auf geeigneten Datentragern bereitgestellt werden.

Unter dem Begriff der ,maschinellen Auswertbarkeit® versteht die Finanzverwaltung den
wahlfreien Zugriff auf alle gespeicherten Daten einschliel3lich der Stammdaten und
Verknupfungen mit Sortier- und Filterfunktionen.

Um eine solche Auswertbarkeit oder Verwertbarkeit zu erreichen, ist es notwendig, dass die
Dateiformate fur die Datentragertberlassung definiert und standardisiert werden.

In diesem Dokument wird ein Verfahren vorgestellt, das die definierte und standardisierte
Datentrageruberlassung ermdglicht und einen Standard flur die Software-Industrie
beschreibt.

Bei Rickfragen wenden Sie sich bitte per E-Mail an sales.de@caseware.com, oder informieren
Sie sich unter https://www.caseware.net.
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Text von § 147 Abs. 6 AO

In der Fassung des Gesetzes zur Senkung der Steuersétze und zur Reform der
Unternehmensbesteuerung (Steuersenkungsgesetz — StSenkG) vom 23.10.2000 BGBI. |
2000 S. 1433:

(6) Sind die Unterlagen nach Absatz 1 mit Hilfe eines Datenverarbeitungssystems erstellt
worden, hat die Finanzbehdrde im Rahmen einer Au3enprifung das Recht, Einsicht in
die gespeicherten Daten zu nehmen und das Datenverarbeitungssystem zur Prifung
dieser Unterlagen zu nutzen. Sie kann im Rahmen einer AuRenprufung auch verlangen,
dass die Daten nach ihren Vorgaben maschinell ausgewertet oder ihr die gespeicherten
Unterlagen und Aufzeichnungen auf einem maschinell verwertbaren Datentrager zur
Verfligung gestellt werden. Die Kosten tragt der Steuerpflichtige.

Datentrageruberlassung
Ein mégliches Szenario fiir eine Steuerpriifung mit Datentrégeriiberlassung:

Ein Steuerprifer bekommt den Auftrag, ein Unternehmen zu prifen. Fur bestimmte
Prufungsfelder und Prifungszeitrdume beschliefl3t der Steuerprifer, die Daten unter
Zuhilfenahme von Prifungssoftware zu analysieren. Entsprechend werden dem
Unternehmen die Priifung angekiindigt und die Prifungsschwerpunkte bekanntgegeben. Der
Steuerprifer bittet das Unternehmen, die steuerlich relevanten Daten auf einem maschinell
auswertbaren Datentrager nach den Vorgaben der ,Grundsatze zum Datenzugriff und zur
Prifbarkeit digitaler Unterlagen® (GDPdU) gemal BMF-Schreiben vom 16.07.2001 bzw. der
,Grundsatze zur ordnungsmafigen Flihrung und Aufbewahrung von Bichern,
Aufzeichnungen und Unterlagen in elektronischer Form sowie zum Datenzugriff‘ (GoBD)
gemal BMF-Schreiben vom 28.11.2019 bereitzustellen.

Bei Prufungsbeginn erhalt der Steuerprifer einen Datentrager oder ein Datenpaket.

Gemal seinem Prifungsschwerpunkt sucht der Priifer die entsprechenden Tabellen heraus
und liest diese ein. Auf dem Datentrager/in dem Datenpaket sind steuerrelevante Daten und
beschreibende Daten enthalten, um die Daten ohne weitere Erklarungen einlesen zu
kénnen. Sobald die Daten in die Analysesoftware importiert sind, fuhrt der Steuerprifer eine
oder mehrere Analysen (teilweise durch Makros automatisiert) aus.

1. Fordert Datentrager/Datenpaket an
2. Liest Datentrager/Datenpaket ein
3. Fuhrt Analyse aus bzw. I&sst Analyse-Makros ablaufen

Abbildung 1: Steuerpriifer
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Aus Sicht des Unternehmens fallen bei dem oben beschriebenen Szenario folgende
Arbeitsschritte an:

e Ein Mitarbeiter initiiert die Datenextraktion bzw. den Export aus der

Produktionsdatenbank, wobei die Daten ggf. (automatisch) transformiert werden in dem

Sinne, dass die Datenorganisation, die Struktur der Tabellen oder Objekte geandert wird.
o Ebenso muss bei komprimierten oder verschliisselten Daten die Komprimierung bzw. die

Verschlisselung aufgehoben werden. Zu den steuerrelevanten Daten muss nun noch

eine Beschreibung in Form einer maschinenauswertbaren Datei erzeugt oder

hinzukopiert werden. Eine solche Datei muss in dem Fall bei der Bereitstellung erzeugt
werden, falls der Softwarehersteller nicht vorhersehen kann, welche Daten bei der
Prufung bereitgestellt werden sollen. Es kann eine statische Datei bereitgestellt werden,

falls im Voraus der Umfang und die Struktur der Daten feststehen.

Die Daten werden anschlieffend automatisch oder manuell auf einem beweglichen

Datentrager/in einem Datenpaket gespeichert.

* Organisation

* Extraktion
| l I * Transformation :3::5:5(; T:;Zn

* Bereitstellung

Produktivsystem

_ * Komprimierung
e SAP

* Datev

e |nfor

* Navision

* Oracle Financials
* Varial

* eigene Software
* andere

Priifer/in

Abbildung 2: Datentrégertiiberlassung
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Die Datenorganisation bei der Datentrageriiberlassung

Das BMF-Schreiben vom 16.07.2001 gibt den gepriften Unternehmen bei der technischen
Organisation des zu Uberlassenden Datentragers/Datenpakets grundsatzlich einen breiten
Spielraum.

Nachdem die Finanzverwaltung des Bundes und der Lander die in der Wirtschaftsprifung
verbreitete Analysesoftware IDEA beschafft hat, sind die Steuerprifer in der Lage, Daten
maschinell zu lesen und (automatisiert oder manuell gesteuert) zu verarbeiten. Die
Finanzverwaltung definiert nicht die Datenfelder und Inhalte, die bei der
Datentrageriberlassung auf den Datentrager/in das Datenpaket gebracht werden.
Entsprechend ist es notwendig, dass Steuerpflichtige und/oder Hersteller von Software, die
steuerlich relevante Daten verarbeiten, selbst entscheiden, welche Daten bei der
Datentrageruberlassung bereitgestellt werden. Dabei kénnen je nach EDV-System,
Software-Strukturen, Unternehmensstruktur und -grofRe unterschiedliche Dateninhalte
sinnvoll und notwendig sein.

Um Ruckfragen durch den Steuerprifer zu den Dateninhalten und Formaten zu minimieren
oder unnétig zu machen, wird hier ein Verfahren beschrieben, das die Daten,
Datenstrukturen und Verknlpfungen beschreibt und kommentiert.

Um die unterschiedlichen Datenstrukturen verarbeiten zu kénnen, stellt der Steuerpflichtige
bzw. sein Berater die steuerrelevanten Daten weitgehend denormalisiert zur Verfiigung.
Zusatzlich liefert er eine maschinenauswertbare Beschreibung der Daten, Datenformate und
Verknupfungen. Das Dateiformat fir die steuerlich relevanten Daten wurde auf gangige
Standardformate festgelegt. Beides — steuerrelevante Daten und Beschreibungsdaten — wird
auf einem gemeinsamen Datentrager/in einem gemeinsamen Datenpaket bereitgestellt.

Steuerrelevante Daten

Datenpaket

1

Beschreibungsdatei:
Datenbeschreibung und- verknipfung

Abbildung 3: Datenorganisation
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Die unterstitzten Dateiformate fur die steuerlich relevanten Daten sind:

e VariableLength
o FixedLength

Damit ist es den Softwaresystemen maoglich, bereits bestehende Exportfilter oder
Speicherungsmechanismen zu nutzen.

Die Finanzverwaltung erlaubt keine Installation von Spezialsoftware zur Entschlisselung
oder zum Dekomprimieren von Daten auf ihren Systemen. Insbesondere beim Postversand
von Datentragern ist jedoch zumindest das Verschlisseln von Daten aus
Datenschutzgriinden erforderlich. Im Beschreibungsstandard ist deshalb vorgesehen, z. B.
Programme zur Entschliisselung oder zum Dekomprimieren direkt vom Datentrager zu
starten, ohne dass sich diese auf dem System der Finanzverwaltung installieren.

Die Computer der Prifer sind mit Zugriffsschutz-Software und ggf. Anti-Viren-Software
ausgestattet. Die Funktionsfahigkeit dieser direkt aufgerufenen Programme sollte deshalb
vom Daten-Bereitsteller im Vorfeld geklart werden. Die Prifung auf Lauffahigkeit dieser
Routinen ist nicht Gegenstand des Beschreibungsstandards.

Die Rolle des Softwareherstellers

Im Folgenden wird als ,Softwarehersteller” — aus Sicht des steuerpflichtigen Unternehmens —
ein externer Lieferant von Software oder einer Datenverarbeitungsanlage inklusive
Programmen oder eine interne Abteilung, die entsprechende Programme bzw. Services
bereitstellt, angenommen.

Gemal den dargestellten Szenarien zur Betriebspriifung muss bei der Betriebsprifung u. a.
eine maschinenauswertbare Beschreibung der Daten und der Verknlpfungen bereitgestellt
werden.

Die Beschreibungsdatei wird von einem Programm gelesen, das gemal dieser
Beschreibung die Import-Funktion des Analyseprogramms des Steuerprifers steuert. Es
werden keine Operationen auf Datenbanken der Produktivsysteme ausgefihrt.

Der Hersteller der Programme bzw. Prozeduren, mit denen das steuerpflichtige
Unternehmen steuerrelevante Daten verarbeitet (Softwarehersteller), muss zusatzlich zu
einer Extraktionsfunktionalitat die Aufbereitung oder Bereitstellung der
Beschreibungsfunktionalitat sicherstellen.

Beschreibungsstandard GDPdU/GoBD 9
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XML-basierter Beschreibungsstandard

Uberblick

XML ist die ,eXtensible Markup Language®. XML gibt nur einen generischen Satz von
Sprachelementen vor, so dass je nach Anwendungsfall eine eigene Sprache definiert werden
muss. Die jeweils neu formulierte Sprache kann durch Strukturinformationen und
Elementdefinitionen in einer DTD (Document Type Definition) maschinenlesbar hinterlegt
werden. Damit kann ein XML-Parser Uberprifen (validieren), ob ein XML-Dokument der
vereinbarten Sprache entspricht. Man unterscheidet also zwischen Sprachbeschreibung in
der DTD und den Inhalten in der XML-Instanz.

In der DTD selbst werden also keine Beschreibungsdaten fiir die Datentrageriberlassung
gespeichert, sondern in der XML-Datei index.xml. Die DTD beschreibt den Aufbau der Datei
index.xml.

Weiterfuhrende Informationen zu XML findet man auf https://www.w3.org.

Allgemeine Annahmen bzw. Voraussetzungen zur DTD

Es wird in der DTD davon ausgegangen, dass die steuerrelevanten Daten in Dateien
organisiert sind. Pro Tabelle wird genau eine Datei angenommen, so dass die Organisation
nach Datei und Tabelle physisch zusammenfallen.

Die Beschreibungsdaten fir die Datentrageriberlassung werden in einer Datei index.xml
gespeichert.

Die DTD muss sich in demselben Verzeichnis auf dem Datentrager/in dem Datenpaket
befinden wie die Datei index.xml.

Werden mehrere Datentrager (Medien) bereitgestellt, muss sich die Datei index.xml nur auf
dem ersten Datentrager befinden.

Beschreibungsstandard GDPdU/GoBD 10
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Technischer Ablauf des Importprozesses

Der Importprozess wird von einer Komponente gesteuert, die die Datei index.xml interpretiert
und die Exporttabellen von den einzelnen Datentragern/Datenpaketen an die Analyse-

Software Ubergibt. Diese Komponente Uberpriift die Datei index.xml auf Korrektheit und dient
dem Prifer als Inhaltsverzeichnis fir die gelieferten Daten.

GDPdU Interpreter

Analyse-
software

Abbildung 4: Importprozess
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Die XML-DTD

<?xml version="1.0" encoding="UTF-8"?>
<l--Versions available:
1.1 (August-01-2002)

1.2 (June-01-2003)
New Element Alias

1.3 (November-01-2003)
New Element Extension

1.4 (May-01-2004)
New Element AcceptNoTables
<Table> is now optional

1.5 (September-01-2004)
Updated the ForeignKey and Alias elements so they allow
multiple Alias elements per ForeignKey. This allows one to use alias
elements for a Composite key.

Example:

<ForeignKey>
<Name>Order</Name>
<Name>Customer</Name>
<References>Orders</References>
<Alias>
<From>Order</From>
<To>Orderld</To>
</Alias>
<Alias>
<From>Customer</From>
<To>Customerld</To>
</Alias>

1.6 (March-03-2019)
Updated the Map and From/To elements descriptions so they allow
importing an Alphanumeric column as Time column.
This allows defining that an Alphanumeric column contains

Example:

<Map>
<From>HHMMSS</From>
<To>HHMMSS</To>
</Map>
>

<l-- Start Simple Types -->

<l-- Supplementary Vocabulary -->
<IELEMENT Version (#PCDATA)>
<IELEMENT Location (#PCDATA)>
<IELEMENT Comment (#PCDATA)>
<IELEMENT Length (#PCDATA)>
<IELEMENT References (#PCDATA)>
<IELEMENT From (#PCDATA)>
<I[ELEMENT To (#PCDATA)>

<!-- Sometimes, it is desirable to have a <Media> with
no tables.

Example:
An extension might provide metadata
that describes all tax-relevant data.

This option is turned off by default. -->
<IELEMENT AcceptNoTables (#PCDATA)>

<!-- Use Alias to reference columns with different names in
a ForeignKey element. These Alias elements are optional.

data of type Time and allows you to specify which is the time format used.

Beschreibungsstandard GDPdU/GoBD
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The following rules apply to the Alias element:
- One Alias can be used per ForeignKey.
- Alias elements can appear in any order.

Example:
Table Orders has a primary key Orderld
Table Accounts has a foreign key Order.

You can use the Alias element to specify Order references Orderld.

<ForeignKey>
<Name>Order</Name>
<Name>Customer</Name>
<References>Orders</References>
<Alias>
<From>Order</From>
<To>Orderld</To>
</Alias>
</ForeignKey> -->
<IELEMENT Alias (From, To)>

<l-- Specifying a maximum length for a VariableLength column can
reduce a VariableLength tables' import time. If MaxLength
is not specified then we parse URL to determine the MaxLength
for each column.

* Only applies to VariableLength tables. -->
<IELEMENT MaxLength (#PCDATA)>

<I-- Specifies which character (if any) encapsulates a
VariableLength AlphaNumeric column.

Doublequote is the default TextEncapsulator "

* Only applies to VariableLength tables. (Optional) -->
<IELEMENT TextEncapsulator (#PCDATA)>

<l-- Specifies how many digits appear to the right of the decimal symbol.

CAUTION: Results are undefined when importing numeric data with
greater Accuracy than the Accuracy defined in index.xml

For example trying to import the value 1000,25 with an
accuracy of 0 might result in 1000 or an error. This
behavior is specific to the implementation.

Zero is the default Accuracy '0' (Optional)
-—>

<IELEMENT Accuracy (#PCDATA)>

<l-- The decimal place is not always stored with numbers. If each number
is supposed to have decimal places use ImpliedAccuracy -->
<IELEMENT ImpliedAccuracy (#PCDATA)>

<l-- Enables you to change how GDPdU displays dates.
DD.MM.YYYY is the default Format -->
<IELEMENT Format (#PCDATA)>

<l-- Specifies the symbol that indicates decimal values.
Comma is the default DecimalSymbol. ',
Specified once per Table. -->
<IELEMENT DecimalSymbol (#PCDATA)>

<l-- Specifies the symbol that groups the digits in large numbers.
Dot is the default DigitGroupingSymbol or ThousandsSeperator. "'
Specified once per Table -->
<IELEMENT DigitGroupingSymbol (#PCDATA)>

<l-- Command(s) are executed in the following manner
* before the import process
* after the import process
* before a Media is imported
* after a Media is imported
-—>

<IELEMENT Command (#PCDATA)>

Beschreibungsstandard GDPdU/GoBD
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<l-- Only the file protocol is supported at this time.
* The standard uses relative URLs.

Absolute URLs are not allowed. The following are all invalid:
* http://www.somewhere.com/data/Accounts.dat
* ftp://ftp.somewhere.com/data/Accounts.dat
* file://localhost/Accounts.dat
* file:///Accounts.dat

The following are valid examples
* Accounts.dat
* data/Accounts.dat
* data/january/Accounts.dat
* ..JAccounts.dat
-—>

<IELEMENT URL (#PCDATA)>

<l-- Textual description of specified element (Optional) -->
<IELEMENT Description (#PCDATA)>

<l-- The logical name of specified element.
Sometimes referred to business name.

If missing, URL will be used in place of Name. -->
<IELEMENT Name (#PCDATA)>

<l-- Y2K Window Any year before Epoch is 2000+
Default value 30. -->
<IELEMENT Epoch (#PCDATA)>

<!I-- Element(s) that separate columns or records.
Semicolon is the default ColumnDelimiter. ";'
CRLF or &#13;&#10; is the default RecordDelimiter. -->
<I[ELEMENT ColumnDelimiter (#PCDATA)>
<IELEMENT RecordDelimiter (#PCDATA)>

<l-- The number of bytes skipped before reading of URL commences.
Zero is the default when not specified. '0'
-—>

<IELEMENT SkipNumBytes (#PCDATA)>

<l-- End Simple Types -->
<l-- Start Complex Types -->

<l-- Use Extension when you want to add application
specific functionality to the existing standard.

Name - the extension name or identifier.
URL - the supplementary .xml file that corresponds to the
extension.

An application that extends the standard should scan the
Dataset element for the presence of zero or more Extension
elements. The application can use the Name element to identify
the extension.

When choosing a name for your extension, do not choose a common
name. This will reduce undefined results for name conflicts.

It is possible that future extensions will be ratified as
mandatory to meet GDPdU guidelines. -->
<IELEMENT Extension (Name, URL)>

<l-- Self-explanatory -->
<I[ELEMENT Range (From, (To | Length)?)>
<IELEMENT FixedRange (From, (To | Length))>

<l-- The document element -->
<IELEMENT DataSet (Extension*, Version, DataSupplier?, Command*, Media+, Command*)>

<l-- Supported datatypes (mandatory) -->

<IELEMENT AlphaNumeric EMPTY>

<IELEMENT Date (Format?)>

<IELEMENT Numeric ((ImpliedAccuracy | Accuracy)?)>

Beschreibungsstandard GDPdU/GoBD
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<l-- Supported codepages:
Be careful to explicitly define RecordDelimiter when using
a non-default codepage.
ANSI is the default codepage when not specified -->
<I[ELEMENT ANSI EMPTY>
<I[ELEMENT Macintosh EMPTY>
<I[ELEMENT OEM EMPTY>
<I[ELEMENT UTF16 EMPTY>
<I[ELEMENT UTF7 EMPTY>
<I[ELEMENT UTF8 EMPTY>

<l-- Supported file formats:

FixedLength

VariableLength -->

<IELEMENT FixedLength ((Length | RecordDelimiter)?, ((FixedPrimaryKey+, FixedColumn*) | (FixedColumn+)),
ForeignKey*)>
<IELEMENT FixedColumn (Name, Description?, (Numeric | AlphaNumeric | Date), Map*, FixedRange)>
<IELEMENT FixedPrimaryKey (Name, Description?, (Numeric | AlphaNumeric | Date), Map*, FixedRange)>
<IELEMENT VariableLength (ColumnDelimiter?, RecordDelimiter?, TextEncapsulator?, ((VariablePrimaryKey+,
VariableColumn*) | (VariableColumn+)), ForeignKey*)>
<IELEMENT VariableColumn (Name, Description?, (Numeric | (AlphaNumeric, MaxLength?) | Date), Map*)>
<IELEMENT VariablePrimaryKey (Name, Description?, (Numeric | (AlphaNumeric, MaxLength?) | Date), Map*)>

<l-- Description of the entity supplying the data. (Optional) -->
<IELEMENT DataSupplier (Name, Location, Comment)>

<l-- The first Media will contain index.xml. Importing will process each media listed -->
<IELEMENT Media (Name, Command*, Table*, Command*, AcceptNoTables?)>

<l-- Elements common to FixedLength & VariableLength are propagated to Table. -->
<IELEMENT Table (URL, Name?, Description?, Validity?, (ANSI | Macintosh | OEM | UTF16 | UTF7 | UTF8)?,
(DecimalSymbol, DigitGroupingSymbol)?, SkipNumBytes?, Range?, Epoch?, (VariableLength | FixedLength))>

<l-- ForeignKeys denote joins or relationships between tables.
To successfully join two tables make sure both the PrimaryKey
and the referenced column (ForeignKey) are of the same datatype.
Results are undefined when joining two tables with different
key datatypes. Most likely an error will occur.

see line 35 for information about Alias -->
<IELEMENT ForeignKey (Name+, References, Alias*)>

<l-- Maps AlphaNumeric columns from 'From' to 'To'

ie. From To
True 1
True -1
False 0

Basically, a map is an associative container.

The standard implementation only supports
AlphaNumeric datatypes. The following
conversions are NOT supported.

Numeric  -> AlphaNumeric
Date -> AlphaNumeric
AplhaNumeric -> Date
AlphaNumeric -> Numeric

In order to keep the backward compatibility and because the Time
data type was not defined yet we allow specifying that an Alphanumeric
column contains data of type Time like:

<Map>
<From>HHMMSS</From>
<To>HHMMSS</To>
</Map>

If the application which interprets the xml and the target application
to import into are able to deal with time data type this column data could
be imported as Time data type

The value of the From element has to be equal with the value of the To
element, in order to not be interpreted as an actual Alphanumeric data mapping
in which the intention is to replace a certain text with a different text at
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import time, and be a valid Time format.

The following formats are recognized as valid Time formats:
HH as symbols for hours

MM as symbols for minutes

SS as symbols for seconds

TT as symbols for AM/PM

SS and TT are optional when defining the format.

A time format separator can also be supplied if needed.

Examples of valid formats:
HHMM, HH:MM, HHMMSS, HHMMTT, HH:MMTT, HH:MM:SS, HHMMSSTT,
HH:MM:SSTT, HHMM TT, HH:MM TT, HHMMSS TT, HH:MM:SS TT

-—>

<IELEMENT Map (Description?, From, To)>

<l-- Documentation for table validity. -->
<IELEMENT Validity (Range, Format?)>

<l-- End Complex Types -->

Abbildung 5: XML-DTD
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Organisation des Beschreibungsstandards

a XML

= version 1.0
= encoding UTF-5
:| DOCTYPEDataSet

! DataSet
{} Version 10
| DataSupplier
{} Hame Glazwark AG
{} Location Singen/Deutschland
| {} Comment Datertrasgeriberlzssung nach GOPAU vom 14 August 2002, Dr. Gréssle, Tel: 07544 934266
Media ()
{} Hame {3} Table
1 CD Mummer 1} ¥ Table
> Table
2 CD Mummer 2 | > Table
> Table
> Table
4 Table
{3} URL hestelungen oy
{} Hame Bestelluncen
{} Description Bestelungen-Bewegungsdaten
| VariableLength
! VariableColumn (5]

]

{}Hame {} AlphaHumeric {} Date {} Humeric
1 Arikel-Mr
2 Kunden-Code
3 Bestellcatum Date
{} Format Y YMMOD
4 Lieferdatum Date
{} Format Y YMMOD
5 Besteldatum Date

{} Format v Y MMDD
_| & Frachtkosten

{ Commend wettere columns .
- ForeignKey (2]
{¥Hame {}References
1 Kunden-Code Kunden
| [ _ 2 | Atikel-D Artikel

Abbildung 6: Beschreibungsstandard — Organisation

Das Basiselement des Beschreibungsstandards ist das DataSet-Element. Hier enthalten sind
die Elemente Version, DataSupplier, Command und Media.

e Version enthalt die Versionsnummer der Datentragerbereitstellung.

e DataSupplier enthalt Angaben Uber die Herkunft der Daten.

¢ Die Media-Container enthalten die Angaben Uber die bereitgestellten Datentrager und die
Tabellen, die darauf gespeichert sind. Hierbei wird fur jedes bereitgestellte
Datentragermedium ein eigener Media-Eintrag vorgenommen. Somit ist es méglich, auch
mehrere Datentrager in einem DataSet zusammenzufassen.
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SVersion
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Abbildung 7: Beschreibungsstandard — DataSet
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Abbildung 8: Beschreibungsstandard — FixedLength
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Abbildung 9: Beschreibungsstandard — VariableLength
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Hinweise zu XML

o Hinweis zu den in XML Ublichen Operatoren:

Operator Elementtyp darf auftreten
? 0-mal oder 1-mal

* 0-mal oder beliebig oft

+ 1-mal oder beliebig oft

Tabelle 3: Ubersicht (iber die gdngigen Operatoren

o #PCDATA steht fir Parsed Character Data und bedeutet, dass das Element fiir einen
Texteintrag vorgesehen ist.
¢ Bei Aufzahlungen werden die mdglichen Werte durch senkrechte Striche (,|*) getrennt.

In XML muss auf Grof3- und Kleinschreibung geachtet werden.

¢ Bitte verwenden Sie in den Beschreibungsfeldern und/oder den Tabellen- und

Spaltennamen keines der folgenden Zeichen: " & < >

Verwenden Sie stattdessen den Namen oder die Nummer aus der untenstehenden Liste.

Zeichen Name Nummer
" &quot; &#34;
& &amp; &#38;
< &lt; &#60;
> &gt; &#62;

Tabelle 4: Liste der Namen und Nummern fiir die Zeichen " & < >
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Beschreibung der Elemente

Es folgt eine Beschreibung der einzelnen ELEMENT-Deklarationen.

Im Allgemeinen gilt, dass die in den jeweiligen Attributen ,description® hinterlegten Texte
dem Prifer als Kommentar angezeigt werden. Die Lange des Textes in den description-
Attributen sollte 255 Zeichen nicht Gberschreiten.

<!ELEMENT Version (#PCDATA)>

Enthalt die Versionsnummer der Datentragerbereitstellung. Dieses Element hat keine
technische Auswirkung, sondern dient zur Beschreibung.

Verwendet in Container

Kontextabhdngige Beschreibung

DataSet

Tabelle 5: ELEMENT Version

<IELEMENT Location (#PCDATA)>
Beschreibt den Standort des Datenlieferanten.

Verwendet in Container

Kontextabhangige Beschreibung

DataSupplier

Tabelle 6: ELEMENT Location

<IELEMENT Comment (#PCDATA)>

Kommentarfeld fir zusatzliche Informationen zum Datenlieferanten.

Verwendet in Container

Kontextabhdngige Beschreibung

DataSupplier

Tabelle 7: ELEMENT Comment

<IELEMENT Length (¥PCDATA)>

Enthalt Informationen Uber die Lange von Attributen oder Datensatzen.

Verwendet in Container

Kontextabhangige Beschreibung

Range

Tabelle 8: ELEMENT Length
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<IELEMENT References (#PCDATA)>
Enthalt Informationen Uber Verknlpfungen.

Verwendet in Container Kontextabhéngige Beschreibung

ForeignKey referenzierte Tabelle

Tabelle 9: ELEMENT References

Siehe hierzu auch das Beispiel auf Seite 43.

<IELEMENT From (#PCDATA)>
Enthalt Informationen Uber den Startwert eines Wertebereichs.

Verwendet in Container Kontextabhdngige Beschreibung

Range Startwert in einem Wertebereich

Map Redefinition von Daten

Alias Name der Spalte der aktuellen Tabelle, die
in einer Fremdschlisseldefinition verwendet
wird

Tabelle 10: ELEMENT From

<IELEMENT To (#PCDATA)>
Enthalt Informationen tUber den Endwert eines Wertebereichs.

Verwendet in Container Kontextabhangige Beschreibung

Range Endwert in einem Wertebereich

Map Redefinition von Daten

Alias Der entsprechende Spaltenname der
referenzierten Tabelle flr einen
FremdschlUssel

Tabelle 11: ELEMENT To

<I[ELEMENT MaxLength (#PCDATA)>

Enthalt Informationen Uber die maximale Léange eines alphanumerischen Feldes in einer
VariableLength-Tabelle.

Verwendet in Container Kontextabhangige Beschreibung
VariableColumn Maximale Lange des Feldes
VariablePrimaryKey Maximale Lange des Feldes

Tabelle 12: ELEMENT MaxLength

Die Angabe von MaxLength bei dem Dateityp VariableLength beschleunigt den
Importprozess, da andernfalls die Datei vor dem Importprozess geprift wird und die
maximalen Langen der Felder ermittelt werden.
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<IELEMENT TextEncapsulator (#PCDATA)>

Bei VariableLength-Dateien kann man Textfelder durch ein ,Encapsulator‘-Zeichen
einschlielRen, z. B. flr den Fall, dass der Feldtrenner in den Daten vorkommt.

Vorgabewert: "

Verwendet in Container Kontextabhéngige Beschreibung

VariableLength

Tabelle 13: ELEMENT TextEncapsulator

<IELEMENT Accuracy (#PCDATA)>

Anzahl der Nachkommastellen. Vorsicht bei Daten, deren Genauigkeit grof3er ist, als in
Accuracy angegeben.

Vorgabewert: 0

Verwendet in Container Kontextabhdngige Beschreibung

Numeric

Tabelle 14: ELEMENT Accuracy

<IELEMENT ImpliedAccuracy (#PCDATA)>

Anzahl der Nachkommastellen, auch wenn in den Quelldaten keine Nachkommastellen
angegeben sind.

Beispiel:
Quelldaten: ,100; 200; 102; 5000; 6587890
ImpliedAccuracy 3:,0,100; 0,200; 0,102; 5,000; 6587,890*

Verwendet in Container Kontextabhangige Beschreibung

Numeric

Tabelle 15: ELEMENT ImpliedAccuracy
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<IELEMENT Format (#PCDATA)>
Angabe Uber Formatdefinitionen.

Vorgabewert: DD.MM.YYYY

Verwendet in Container

Kontextabhangige Beschreibung

Date

Hier wird die Maskierung fir die Darstellung
von Datumsangaben hinterlegt.

Folgende Angaben fiur Format sind gliltig:

e DD fir Tag,
e MM flr Monat,
e YY bzw. YYYY flr Jahr.

Beispiel (30. September 2001)

MM/DD/YY: 09/30/01
DD.MM.YY: 30.09.01
MM/DD/YYYY: 09/30/2001
YYYY-MM-DD: 2001-09-30
DDMMYY: 300901
DDMMYYYY: 30092001

Validity

Maskierung fir das verwendete
Datumsformat (siehe Date)

Tabelle 16: ELEMENT Format

<IELEMENT DecimalSymbol (#PCDATA)>

Angabe Uber das Dezimalstellen-Trennzeichen.

Vorgabewert: ,

Verwendet in Container

Kontextabhangige Beschreibung

Table

Tabelle 17: ELEMENT DecimalSymbol

<IELEMENT DigitGroupingSymbol (#PCDATA)>

Definiert das Tausender-Trennzeichen.

Vorgabewert: .

Verwendet in Container

Kontextabhangige Beschreibung

Table

Tabelle 18: ELEMENT DigitGroupingSymbol
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<!IELEMENT Command (#PCDATA)>

Definiert ein Betriebssystemkommando. Commands kdnnen an folgenden Stellen ausgefihrt
werden:

e vor dem gesamten Importprozess

e nach dem gesamten Importprozess

e Dbevor ein einzelner Datentrager importiert wird

¢ nachdem ein einzelner Datentrager importiert wurde
Verwendet in Container Kontextabhangige Beschreibung
DataSet Command fir den gesamten Vorgang
Media Command fiur einen einzelnen Datentrager

Tabelle 19: ELEMENT Command

Siehe hierzu auch das Beispiel auf Seite 46.

<IELEMENT URL (#PCDATA)>
Dieses Element enthalt den physischen Dateinamen der bereitgestellten Datei.

In dieser Version des Beschreibungsstandards werden ausschlielich relative URLs
unterstitzt. Als Basisverzeichnis gilt der Pfad zur Datei index.xml.

Beispiele fur ungiiltige Eintrage:
http://www.somewhere.com/data/Accounts.csv
ftp://ftp.somewhere.com/data/Accounts.csv

Beispiele fur giiltige Eintrage:
Accounts.dat
data/Accounts.dat
data/january/Accounts.dat
../Accounts.dat

Verwendet in Container Kontextabhangige Beschreibung

Table

Tabelle 20: ELEMENT URL
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<IELEMENT Description (#PCDATA)>
Beschreibungsfeld

Verwendet in Container

Kontextabhangige Beschreibung

FixedColumn

Beschreibungsfeld fur Spalten in
FixedLength-Dateien

FixedPrimaryKey

Beschreibungsfeld fiir Schlissel in
FixedLength-Dateien

VariableColumn

Beschreibungsfeld fur Spalten in
VariableLength-Dateien

VariablePrimaryKey Beschreibungsfeld fiir Schlissel in
VariableLength-Dateien

Table Beschreibungsfeld fir Tabellen

Map Beschreibungsfeld fiir Redefinition von

Daten

Tabelle 21: ELEMENT Description

<IELEMENT Name (#PCDATA)>
Beschreibungsfeld

Vorgabewert: Angabe aus dem URL-Element

Verwendet in Container

Kontextabhangige Beschreibung

FixedColumn

Spaltenname in FixedLength-Dateien

FixedPrimaryKey Schlusselname in FixedLength-Dateien
VariableColumn Spaltenname in VariableLength-Dateien
VariablePrimaryKey Schliusselname in VariableLength-Dateien

DataSupplier

Name des Datenlieferanten
(Firmenname, ...)

Media Datentrédger-Name
URL Physischer Tabellenname
ForeignKey Name des Fremdschlissels

Tabelle 22: ELEMENT Name
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<IELEMENT Epoch (#PCDATA)>

Fir Daten, die eine 2-ziffrige Jahresangabe haben, kann ein Standardplatzhalter definiert
werden, der 19xx von 20xx trennt. Dieser Wert ist mit 30 vorbelegt.

In einigen Dateien konnte das Datum 25. November 55 entweder 1955 oder 2055 bedeuten.
Mit Epoch wird eingestellt, bis zu welchem zweistelligen Wert das Jahr als im nachsten
Jahrhundert liegend interpretiert werden soll. Steht beispielsweise im Feld Jahrhundert-
Trennwert der Wert 50, so werden alle Jahresangaben von 0 bis 49 als die Jahre 2000 bis
2049, die Jahresangaben 50 bis 99 als 1950 bis 1999 interpretiert.

Vorgabewert: 30

Verwendet in Container Kontextabhdngige Beschreibung

Table

Tabelle 23: ELEMENT Epoch

<IELEMENT ColumnDelimiter(#PCDATA)>
Definiert Trennzeichen fir Datenfelder.

Vorgabewert: &#59; (Semikolon ,;“)

Verwendet in Container Kontextabhangige Beschreibung

VariableLength Datenfeld-Trennzeichen

Tabelle 24: ELEMENT ColumnDelimiter

Beispiel fir Ubliche Trennzeichen:

Trennzeichen XML-Notation
Komma ,,,“ &#44;
Semikolon ,;* &#59;

Tab &#9;

Tabelle 25: ELEMENT ColumnDelimiter — Liste gdngiger Trennzeichen
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<IELEMENT RecordDelimiter (#PCDATA)>

Definiert Trennzeichen flr Datenséatze.

Vorgabewert: &#13;&#10; (CRLF)

Verwendet in Container

Kontextabhangige Beschreibung

FixedLength

Datensatz-Trennzeichen

VariableLength

Datensatz-Trennzeichen

Tabelle 26: ELEMENT RecordDelimiter

Beispiel fur tbliche Trennzeichen:

Trennzeichen

XML-Notation

CR Carriage Return &#13;
CRLF &#13;&#10;
LF Linefeed &#10;

Tabelle 27: ELEMENT RecordDelimiter — Liste gédngiger Trennzeichen

<IELEMENT SkipNumBytes (#PCDATA)>

Falls eine Datei am Beginn unerwlinschte Daten enthalt, wie z. B. Datei-Header, ist hier
anzugeben, wie viele Bytes Ubersprungen und nicht gelesen werden sollen.

Vorgabewert: 0

Verwendet in Container

Kontextabhangige Beschreibung

Table

Tabelle 28: ELEMENT SkipNumBytes

<IELEMENT Range (From, (To | Length)?)>

Definiert einen Bereich oder einen Startwert.

Startwert bedeutet: Wird kein To oder Length angegeben, definiert dieser Range nur einen

Startwert (z. B. eine Datensatzposition).

Verwendet in Container

Kontextabhangige Beschreibung

Table

Startdatensatz

Validity

Gliltigkeitsbereich

Tabelle 29: ELEMENT Range
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<IELEMENT FixedRange (From, (To | Length))>
Definiert einen Bereich mit Angabe von From und To oder From und Length.

Verwendet in Container

Kontextabhangige Beschreibung

FixedColumn

Feldposition in FixedLength-Dateien

FixedPrimaryKey

Schlisselposition in FixedLength-Dateien

Tabelle 30: ELEMENT FixedRange

<IELEMENT DataSet (Version, DataSupplier?, Command*, Media+,

Command*)>

Das Element DataSet ist das oberste Element (document-Element) in der Hierarchie des
XML-Dokumentes. Das Element DataSet ist Trager der Version, Datenherkunft, Vorlauf- und
Nachlauf-Prozesse und der Medien, die die Tabellen enthalten.

<IELEMENT AlphaNumeric EMPTY>
Definiert den Datentyp als alphanumerisch.

Verwendet in Container

Kontextabhangige Beschreibung

FixedColumn

Typ des Feldes in FixedLength-Datei

FixedPrimaryKey Typ des Schlissels in FixedLength-Datei
VariableColumn Typ des Feldes in VariableLength-Dateien
VariablePrimaryKey Typ des Schlussels in VariableLength-

Dateien

Tabelle 31: ELEMENT AlphaNumeric

<IELEMENT Date (Format?)>
Definiert den Datentyp als Datum.

Verwendet in Container

Kontextabhangige Beschreibung

FixedColumn

Typ des Feldes in FixedLength-Datei

FixedPrimaryKey Typ des Schlussels in FixedLength-Datei
VariableColumn Typ des Feldes in VariableLength-Dateien
VariablePrimaryKey Typ des Schliussels in VariableLength-

Dateien

Tabelle 32: ELEMENT Date
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<IELEMENT Numeric ((ImpliedAccuracy | Accuracy)?)>
Definiert den Datentyp als numerisch.

Verwendet in Container Kontextabhangige Beschreibung

FixedColumn Typ des Feldes in FixedLength-Datei

FixedPrimaryKey Typ des Schlissels in FixedLength-Datei

VariableColumn Typ des Feldes in VariableLength-Dateien

VariablePrimaryKey Typ des Schlissels in VariableLength-
Dateien

Tabelle 33: ELEMENT Numeric

<IELEMENT ANSI EMPTY>
Legt die Verwendung der Codepage ANSI fest.

<IELEMENT Macintosh EMPTY>
Legt die Verwendung der Codepage Macintosh fest.

<IELEMENT OEM EMPTY>
Legt die Verwendung der Codepage IBM-PC-ASCI| fest.

<IELEMENT UTF16 EMPTY>
Legt die Verwendung der Codepage UTF16 fest.

<IELEMENT UTF7 EMPTY>
Legt die Verwendung der Codepage UTF7 fest.
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<IELEMENT UTF8 EMPTY>
Legt die Verwendung der Codepage UTF8 fest.

Vorgabewert: ANSI

Plattform

Zeichensatz

Unix-Rechner

7-Bit-ASCIlI-Zeichensatz (7-Bit-ISO Code,
US-Variante), nur Zeichen mit ASCII-Code
kleiner 128, also Buchstaben, Ziffern und
Sonderzeichen (Punkt, Komma etc.) ohne
nationale Sonderzeichen (Umlaute etc.) und
ohne Grafikzeichen. Zeilentrenner ist LF
(Line Feed), das Zeichen 10.

PC unter DOS

8-Bit-Zeichensatz ,IBM-PC-ASCII“, der in
den unteren 127 Zeichen dem 7-Bit-ASCI|
entspricht und ab Zeichen 128 nationale
Sonderzeichen und (Semi-)Grafikzeichen
enthalt. Zeilentrenner ist die Folge CR und
LF, das sind die Zeichen 12 und 10
(Carriage Return, Line Feed).

PC unter Windows

8-Bit-ANSI-Zeichensatz, der bis 127 ASCII
entspricht und oberhalb 127 nationale
Sonderzeichen enthalt, die nicht mit denen
des IBM-PC-ASCII Ubereinstimmen.
Zeilentrenner ist wie unter DOS die Folge
CR, LF. (Spezielle Anwendungen kdnnen
auch einen 16-Bit-Code, den Unicode,
benutzen.)

Apple Mac

Mac-spezifischer 8-Bit-Zeichensatz ,Mac-
ASCII¥, der bis 127 ASCII entspricht und
oberhalb 127 nationale Sonderzeichen
enthalt. Zeilentrenner ist CR.

Tabelle 34: ELEMENT UTF8

Die Wahl der Codepage setzt keine Vorgabe fir den RecordDelimiter. Sie missen den
RecordDelimiter immer explizit angeben, wenn der Vorgabewert (CRLF) nicht geeignet ist.
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<IELEMENT FixedLength ((Length | RecordDelimiter)?, ((FixedPrimaryKey+,
FixedColumn*) | (FixedColumn+)), ForeignKey*)>

Definiert eine Datei vom Typ FixedLength.

Verwendet in Container

Kontextabhdngige Beschreibung

Table

Tabelle 35: ELEMENT FixedLength

<IELEMENT FixedColumn (Name, Description?, (Numeric | AlphaNumeric |

Date), Map*, FixedRange)>

Definiert eine Spalte (= Column) in einer Datei vom Typ FixedLength.

Verwendet in Container

Kontextabhdngige Beschreibung

FixedLength

Tabelle 36: ELEMENT FixedColumn

<IELEMENT FixedPrimaryKey (Name, Description?, (Numeric | AlphaNumeric |

Date), Map*, Range)>

Definiert ein Schlusselfeld (= Key) in einer Datei vom Typ FixedLength.

Verwendet in Container

Kontextabhangige Beschreibung

FixedLength

Tabelle 37: ELEMENT FixedPrimaryKey

Siehe hierzu auch das Beispiel auf Seite 43.

<IELEMENT VariableLength (ColumnDelimiter?, RecordDelimiter?,
TextEncapsulator?, ((VariablePrimaryKey+, VariableColumn®) |

(VariableColumn+))?, ForeignKey*)>
Definiert eine Datei vom Typ VariableLength.

Verwendet in Container

Kontextabhangige Beschreibung

Table

Tabelle 38: ELEMENT VariableLength

Die Felder (VariableColumn, VariablePrimaryKey) missen in der Reihenfolge definiert

werden, in der sie in der Datei geliefert werden.
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<IELEMENT VariableColumn (Name, Description?, (Numeric | AlphaNumeric,
MaxLength ? | Date), Map*)>
Definiert eine Spalte (= Column) in einer Datei vom Typ VariableLength.

Verwendet in Container Kontextabhdngige Beschreibung

VariableLength

Tabelle 39: ELEMENT VariableColumn

Die Felder (VariableColumn, VariablePrimaryKey) missen in der Reihenfolge definiert
werden, in der sie in der Datei geliefert werden.

<IELEMENT VariablePrimaryKey (Name, Description?, (Numeric |
AlphaNumeric, MaxLength ? | Date), Map*)>

Definiert ein Schlusselfeld (= Key) in einer Datei vom Typ VariableLength.

Verwendet in Container Kontextabhdngige Beschreibung

VariableLength

Tabelle 40: ELEMENT VariablePrimaryKey

Die Felder (VariableColumn, VariablePrimaryKey) missen in der Reihenfolge definiert
werden, in der sie in der Datei geliefert werden.

Zu Verknupfungen siehe auch das Beispiel auf Seite 43.

<IELEMENT DataSupplier (Name, Location, Comment)>
Enthalt Angaben zum Datenlieferanten.

Verwendet in Container Kontextabhangige Beschreibung

DataSet Lieferant (Firma, ...)

Tabelle 41: ELEMENT DataSupplier

<IELEMENT Media (Name, Command*, Table+, Command*)>
Definiert den Inhalt eines Datentragers.

Verwendet in Container Kontextabhangige Beschreibung

DataSet Datentrageriberlassung

Tabelle 42: ELEMENT Media

Beschreibungsstandard GDPdU/GoBD

34




caseware

<IELEMENT Table (URL, Name?, Description?, Validity?, (ANSI | Macintosh |
OEM | UTF16 | UTF7 | UTF8)?, (DecimalSymbol, DigitGroupingSymbol)?,
SkipNumBytes?, Range?, (VariableLength | FixedLength)?)>

Definiert eine Tabelle.

Verwendet in Container Kontextabhéngige Beschreibung

Media Tabelle

Tabelle 43: ELEMENT Table

<IELEMENT ForeignKey (Name+, References, Alias*)>
Definiert eine Spalte als Fremdschllssel.

Die Spalte, auf die mit Namen Bezug genommen wird, muss in der gleichen Tabelle als
FixedPrimaryKey/FixedColumn oder VariablePrimaryKey/VariableColumn definiert sein.
References ist der Name der referenzierten Tabelle und Alias wird verwendet, wenn die

referenzierte Spalte in der referenzierten Tabelle einen anderen Namen hat, siehe Definition

des Elements Alias fir weitere Informationen.

Verwendet in Container Kontextabhdngige Beschreibung

FixedLength Feld in FixedLength-Datei, referenzierte
Tabelle

VariableLength Feld in VariableLength-Datei, referenzierte
Tabelle

Tabelle 44: ELEMENT ForeignKey

Siehe hierzu auch das Beispiel auf Seite 43.
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<IELEMENT Map (Description?, From, To)>
Mit dem Element Map kénnen Redefinitionen auf Datenebene vorgenommen werden.

Beispiel:
From (Ausgangsdaten) To (Zieldaten)
1 wahr
0 falsch
Hr Herr
Fr Frau
01 verheiratet
02 ledig
03 Steuerklasse 3

Tabelle 45: ELEMENT Map — Redefinitionen
Verwendet in Container Kontextabhdngige Beschreibung
FixedColumn Feld in FixedLength-Datei
FixedPrimaryKey Schlussel in FixedLength-Datei
VariableColumn Feld in VariableLength-Dateien
VariablePrimaryKey Schlissel in VariableLength-Dateien

Tabelle 46: ELEMENT Map

Map darf nur fir alphanumerische Felder benutzt werden.

Sie sollten vermeiden, in der Datentragertberlassung kodierte Felder zu liefern, sondern alle
Codes in die textuelle Beschreibung umwandeln. Wenn diese Umwandlung nicht bereits von
dem Exportprogramm vorgenommen wird, ist Map eine Méglichkeit, Codes Uber die
Datenbeschreibung umzuwandeln.

Mit Map kénnen Sie auch angeben, dass eine alphanumerische Spalte Daten vom Typ Zeit
enthalt:

<Map>
<From>HHMMSS</From>
<To>HHMMSS</To>
</Map>

Wenn die Anwendung, die die XML-Datei interpretiert, und die Zielanwendung, in die
importiert werden soll, mit dem Datentyp Zeit umgehen kdnnen, kdnnen die Daten dieser
Spalte als Datentyp Zeit importiert werden.
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Der Wert des From-Elements muss gleich dem Wert des To-Elements sein, damit er nicht als
alphanumerisches Daten-Mapping interpretiert wird, bei dem ein bestimmter Text beim
Import durch einen anderen Text ersetzt werden soll, und ein gultiges Time-Format ist.

Die folgenden Formate werden als gliltige Zeitformate anerkannt:
HH als Symbole fiir Stunden
MM als Symbole fir Minuten
SS als Symbole flr Sekunden
TT als Symbole fur AM/PM
SS und TT sind bei der Definition des Formats optional.
Bei Bedarf kann auch ein Zeitformattrennzeichen angegeben werden.

Beispiele fur gultige Formate:
HHMM, HH:MM, HHMMSS, HHMMTT, HH:MMTT, HH:MM:SS, HHMMSSTT,
HH:MM:SSTT, HHMM TT, HH:MM TT, HHMMSS TT, HH:MM:SS TT

<IELEMENT Validity (Range, Format?)>
Definiert den Gliltigkeitszeitraum der Daten.

Verwendet in Container Kontextabhdngige Beschreibung
Table Glultigkeitszeitraum

Tabelle 47: ELEMENT Validity

<IELEMENT AcceptNoTables (#PCDATA)>
Legt fest, dass ein <Media> keine Tabellen hat.

Verwendet in Container Kontextabhangige Beschreibung
Media Media hat keine Tabellen

Tabelle 48: ELEMENT AcceptNoTables

Manchmal ist es wiinschenswert, ein <Media> ohne Tabellen zu haben.

Beispiel:

Eine Erweiterung kénnte Metadaten bereitstellen, die alle steuerrelevanten Daten
beschreiben.
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<IELEMENT Alias (From, To)>

Definiert das entsprechende Spaltennamenpaar bei der Definition einer
FremdschlUsselreferenz.

Verwendet in Container Kontextabhangige Beschreibung

ForeignKey Fir einen Spaltennamen den Namen der
Spalte angeben, auf die er in der
referenzierten Tabelle verweist

Tabelle 49: ELEMENT Alias

Verwenden Sie Alias, um auf Spalten mit unterschiedlichen Namen in einem ForeignKey-
Element zu verweisen. Diese Alias-Elemente sind optional.
Die folgenden Regeln gelten fur das Alias-Element:

e Ein oder mehrere Alias-Elemente kdnnen pro ForeignKey verwendet werden.
¢ Alias-Elemente kénnen in beliebiger Reihenfolge erscheinen.

Beispiel:
Die Tabelle Orders hat einen Primarschlissel Orderld
Die Tabelle Accounts hat einen Fremdschliissel Order.

Sie kénnen das Alias-Element verwenden, um anzugeben, dass Order auf Orderld verweist.

<ForeignKey>
<Name>Order</Name>
<Name>Customer</Name>
<References>0Orders</References>
<Alias>
<From>Order</From>
<To>Orderld</To>
</Alias>
</ForeignKey>
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<IELEMENT Extension (Name, URL)>

Ermoglicht es lhnen, den bestehenden Standard um anwendungsspezifische Funktionen zu
erweitern.

Verwendet in Container Kontextabhangige Beschreibung

DataSet

Tabelle 50: ELEMENT Extension

Verwenden Sie Extension, wenn Sie dem bestehenden Standard anwendungsspezifische
Funktionen hinzufigen mochten.

Name — Name oder Kennung der Erweiterung.
URL — zusatzliche XML-Datei, die der Erweiterung entspricht.

Eine Anwendung, die den Standard erweitert, sollte das Element Dataset auf das
Vorhandensein von null oder mehr Extension-Elementen tUberprifen. Die Anwendung kann
das Element Name verwenden, um die Erweiterung zu identifizieren.

Wenn Sie einen Namen fur Ihre Erweiterung wahlen, sollten Sie keinen allgemeinen Namen
wahlen. Dadurch werden undefinierte Ergebnisse fur Namenskonflikte vermieden.

Es ist mdglich, dass zukiinftige Erweiterungen als obligatorisch eingestuft werden, um die
GDPdU-/GoBD-Richtlinien zu erfllen.
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Beispiel 1 fur eine Datei index.xml

<?xml version="1.0" encoding="UTF-8"?>
<IDOCTYPE DataSet SYSTEM "gdpdu-01-08-2002.dtd">
<DataSet>
<Version>1.0</Version>
<DataSupplier>
<Name>Glaswerk AG</Name>
<Location>Singen/Deutschland</Location>
<Comment>Datentraegeriberlassung nach GDPdU vom 14.August 2002, Dr. Gréassle, Tel: 07544
934266</Comment>
</DataSupplier>
<Media>
<Name>CD Nummer 1</Name>
<Table>
<URL>Account.csv</URL>
<Name>Account</Name>
<Description>Accounts Receivables</Description>
<I-- Diese Tabelle gilt von 1.Januar 2000- 31.Dezember 2002 -->
<Validity>
<Range>
<From>20000101</From>
<T0>20021231</To>
</Range>
<Format>YYYYMMDD</Format>
</Validity>
<I-- Spezifiziert den Dezimaltrenner -->
<DecimalSymbol>.</DecimalSymbol>
<I-- Spezifiziert den Tausender-Separator -->
<DigitGroupingSymbol>,</DigitGroupingSymbol>
<VariableLength>
<!-- ein zusammengesetzter Primaerschlissel -->
<VariablePrimaryKey>
<Name>Regionld</Name>
<AlphaNumeric/>
</VariablePrimaryKey>
<VariablePrimaryKey>
<Name>ld</Name>
<AlphaNumeric/>
</VariablePrimaryKey>
<VariableColumn>
<Name>Account Description</Name>
<AlphaNumeric/>
</VariableColumn>
<VariableColumn>
<Name>Balance</Name>
<Numeric/>
</VariableColumn>
<VariableColumn>
<Name>Old Balance</Name>
<Numeric/>
</VariableColumn>
</VariableLength>
</Table>
<Table>
<URL>Region.csv</URL>
<VariableLength>
<VariablePrimaryKey>
<Name>Regionld</Name>
<AlphaNumeric/>
</VariablePrimaryKey>
<VariableColumn>
<Name>Description</Name>
<AlphaNumeric/>
</VariableColumn>
</VariableLength>
</Table>
</Media>
<Media>
<Name>CD Nummer 2</Name>
<Table>
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<URL>Sales.csv</URL>
<Range>
<From>56</From>
</Range>
<FixedLength>
<FixedPrimaryKey>
<Name>Salesld</Name>
<AlphaNumeric/>
<FixedRange>
<!-- Position des Feldes: -->
<From>1</From>
<To>10</To>
</FixedRange>
</FixedPrimaryKey>
<FixedColumn>
<Name>Regionld</Name>
<AlphaNumeric/>
<FixedRange>
<From>11</From>
<Length>10</Length>
</FixedRange>
</FixedColumn>
<FixedColumn>
<Name>ld</Name>
<AlphaNumeric/>
<FixedRange>
<From>21</From>
<To>30</To>
</FixedRange>
</FixedColumn>
<FixedColumn>
<Name>SalesComplete</Name>
<AlphaNumeric/>
<I-- Redefinition des Wertes "1" nach "True" und "0" nach "False" -->
<Map>
<From>1</From>
<To>True</To>
</Map>
<Map>
<From>0</From>
<To>False</To>
</Map>
<FixedRange>
<From>31</From>
<To>32</To>
</FixedRange>
</FixedColumn>
<!-- ein zusammengesetzter Fremdschluessel der den Primaerschluessel in Tabelle Account
referenziert -->
<ForeignKey>
<Name>Regionld</Name>
<Name>ld</Name>
<References>Account</References>
</ForeignKey>
</FixedLength>
</Table>
<Table>
<URL>kunden.csv</URL>
<Name>Kunden</Name>
<Description>Kunden-Stammdaten</Description>
<VariableLength>
<VariablePrimaryKey>
<Name>Kunden-Code</Name>
<AlphaNumeric/>
</VariablePrimaryKey>
<VariableColumn>
<Name>Firma</Name>
<AlphaNumeric/>
</VariableColumn>
<VariableColumn>
<Name>Kontaktperson</Name>
<AlphaNumeric/>
</VariableColumn>
<!-- weitere columns... -->
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</VariableLength>
</Table>
<Table>
<URL>artikel.csv</URL>
<Name>Artikel</Name>
<Description>Artikel-Stammdaten</Description>
<VariableLength>
<VariablePrimaryKey>
<Name>Artikel-Nr</Name>
<AlphaNumeric/>
</VariablePrimaryKey>
<VariableColumn>
<Name>Artikelname</Name>
<AlphaNumeric/>
</VariableColumn>
<VariableColumn>
<Name>Lieferanten-Nr</Name>
<AlphaNumeric/>
</VariableColumn>
<!-- weitere columns... -->
</VariableLength>
</Table>
<Table>
<URL>bestellungen.csv</URL>
<Name>Bestellungen</Name>

<VariableLength>
<VariableColumn>
<Name>Artikel-Nr</Name>
<AlphaNumeric/>
</VariableColumn>
<VariableColumn>
<Name>Kunden-Code</Name>
<AlphaNumeric/>
</VariableColumn>
<VariableColumn>
<Name>Bestelldatum</Name>
<Date>
<Format>YYYYMMDD</Format>
</Date>
</VariableColumn>
<VariableColumn>
<Name>Lieferdatum</Name>
<Date>
<Format>YYYYMMDD</Format>
</Date>
</VariableColumn>
<VariableColumn>
<Name>Bestelldatum</Name>
<Date>
<Format>YYYYMMDD</Format>
</Date>
</VariableColumn>
<VariableColumn>
<Name>Frachtkosten</Name>
<Numeric/>
</VariableColumn>
<!-- weitere columns... -->
<ForeignKey>
<Name>Kunden-Code</Name>
<References>Kunden</References>
</ForeignKey>
<ForeignKey>
<Name>Artikel-ID</Name>
<References>Artikel</References>
</ForeignKey>
</VariableLength>
</Table>
</Media>
</DataSet>

<Description>Bestellungen-Bewegungsdaten</Description>

Abbildung 10: Beispiel 1 — Datei index.xml
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Beispiel 2 fur Verknupfungen

In der Datentrageruberlassung kann es sinnvoll sein, Bewegungsdaten und Stammdaten
nicht in einer breiten Tabelle zu liefern, sondern in getrennten Tabellen abzuspeichern:

Beispiel:

Kunden

o

KUNDEN_CODE
FIRMA
[KONTAKTPERSON
IPOSITION
STRARE

Artikel

*
ARTKEL_NR

ARTIKELNAME

LEFERANTEN_NR
KATEGORIENR

ORT

Bestellungen

LEFEREINHEIT

REGION
PLZ
LAND
TELEFON
[TELEFAX

EINZELPREIS

*

ARTIKEL_NR

(| [KUNDEN_CODE

[BESTELLDATUM
LIEFERDATUM
FRACHTKOSTEN
[EMPFANGER
STRARE

omT
[BESTIMMUNGSLAND
[EINZELPREIS
ANZAHL

RABATT

LAGERBESTAND
BESTELLTEEINHEITEN
MINDESTBESTAND
AUSLAUFARTIKEL

Abbildung 11: Beispiel 2 — Tabellen mit Bewegungsdaten und Stammdaten

In den Stammdaten werden die Primarschliissel beschrieben:

<Table>
<URL>kunden.csv</URL>
<Name>Kunden</Name>

<VariableLength>
<VariablePrimaryKey>
<Name>Kunden-Code</Name>
<AlphaNumeric/>
</VariablePrimaryKey>
<VariableColumn>
<Name>Firma</Name>
<AlphaNumeric/>
</VariableColumn>
<VariableColumn>
<Name>Kontaktperson</Name>
<AlphaNumeric/>
</VariableColumn>
<I-- weitere columns... -->
</VariableLength>
</Table>

<Description>Kunden-Stammdaten</Description>

<Table>

<URL>artikel.csv</URL>
<Name>Artikel</Name>
<Description>Artikel-Stammdaten</Description>
<VariableLength>
<VariablePrimaryKey>
<Name>Artikel-Nr</Name>
<AlphaNumeric/>
</VariablePrimaryKey>
<VariableColumn>
<Name>Artikelname</Name>
<AlphaNumeric/>
</VariableColumn>
<VariableColumn>
<Name>Lieferanten-Nr</Name>
<AlphaNumeric/>
</VariableColumn>
<!-- weitere columns... -->
</VariableLength>

</Table>

Abbildung 12: Beispiel 2 — Stammdaten
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Die Bewegungsdaten beschreiben die Verknipfungen zu den Stammdaten ber die Angabe

der Fremdschlisselbeziehung:

<Table>
<URL>bestellungen.csv</URL>
<Name>Bestellungen</Name>

<VariableLength>
<VariableColumn>
<Name>Artikel-Nr</Name>
<AlphaNumeric/>
</VariableColumn>
<VariableColumn>
<Name>Kunden-Code</Name>
<AlphaNumeric/>
</VariableColumn>
<VariableColumn>
<Name>Bestelldatum</Name>
<Date>
<Format>YYYYMMDD</Format>
</Date>
</VariableColumn>
<VariableColumn>
<Name>Lieferdatum</Name>
<Date>
<Format>YYYYMMDD</Format>
</Date>
</VariableColumn>
<VariableColumn>
<Name>Bestelldatum</Name>
<Date>
<Format>YYYYMMDD</Format>
</Date>
</VariableColumn>
<VariableColumn>
<Name>Frachtkosten</Name>
<Numeric/>
</VariableColumn>
<I-- weitere columns... -->
<ForeignKey>
<Name>Kunden-Code</Name>
<References>Kunden</References>
</ForeignKey>
<ForeignKey>
<Name>Artikel-Nr</Name>
<References>Artikel</References>
</ForeignKey>
</VariableLength>
</Table>

<Description>Bestellungen-Bewegungsdaten</Description>

Abbildung 13: Beispiel 2 — Bewegungsdaten
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Bitte beachten Sie:

Wahrend die Beschreibung eines VariablePrimaryKey die Spalte vollstadndig beschreibt,
definiert ForeignKey keine neue Spalte. Die im ForeignKey benutzte Spalte muss vorher
bereits als VariableColumn oder FixedColumn definiert worden sein.

<ForeignKey>
<Name>FIRM</Name>
<Name>DDKZ</Name>
<Name>KKKZ</Name>
<Name>UKTO</Name>
<Name>BUJM</Name>
<References>FPCPDPU</References>
<Alias>
<From>UKTO</From>
<To>CKTO</To>
</Alias>
<Alias>
<From>BUJM</From>
<To>GAJM</To>
</Alias>
</ForeignKey>

Abbildung 14: Beispiel 2 — Beispiel eines Fremdschliissels mit mehreren Aliassen
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Beispiel 3 fur eine Datei index.xml (komprimierte Daten)

index.xml

<?xml version="1.0" encoding="UTF-8"?>
<IDOCTYPE DataSet SYSTEM "gdpdu-01-08-2002.dtd">
<DataSet>
<Version>1.2</Version>
<DataSupplier>
<Name>Audicon GmbH</Name>
<Location>Germany</Location>
<Comment>A compressed sample DataSet</Comment>
</DataSupplier>
<Command>uncompress.bat</Command>
<Media>
<Name>Disk 1</Name>
<Table>
<URL>dummy.csv</URL>
<VariableLength>
<VariablePrimaryKey>
<Name>dummy</Name>
<Numeric/>
</VariablePrimaryKey>
</VariableLength>
</Table>
</Media>
</DataSet>

Abbildung 15: Beispiel 3 — Datei index.xml

uncompress.bat

rem
rem uncompress.bat

rem expandiert gdpdu.zip in das windows-temp-verzeichnis, unterverzeichnis gdpdu
rem
mkdir %temp%\gdpdu

pkunzip gdpdu.zip %temp%\gdpdu

Abbildung 16: Beispiel 3 — Datei uncompress.bat

%temp% ist eine Betriebssystem-Umgebungsvariable, die den Pfad zum Temporar-
Verzeichnis reprasentiert.

Die Datei gdpdu.zip enthalt die gepackte Datentragerbereitstellung (einschlie3lich der Datei
index.xml und gdpdu-01-08-2002.dtd). Der Prifer 6ffnet nach dem Dekomprimieren also die
neue Datenbereitstellung in dem Verzeichnis % TEMP%\gdpdu.

Bitte beachten Sie:

Die <Version>-Angabe bezieht sich nicht auf die Version des Beschreibungsstandards,
sondern auf die Version der Datentrageruberlassung.
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Beispiel 4 fur eine Datei index.xml (Datentyp Zeit)

index.xml

<?xml version="1.0" encoding="utf-8" standalone="no"?>
<!DOCTYPE DataSet SYSTEM "gdpdu-01-03-2019.dtd">
<DataSet>
<Version>1.0.00</Version>
<DataSupplier>
<Name />
<Location />
<Comment>SmartExporter</Comment>
</DataSupplier>
<Media>
<Name>Disk1</Name>
<Table>
<URL>20181120175609__ BKPF.csv</URL>
<Name>BKPF</Name>
<Description>
</Description>
<UTF8 />
<DecimalSymbol>.</DecimalSymbol>
<DigitGroupingSymbol>,</DigitGroupingSymbol>
<VariablelLength>
<ColumnDelimiter> </ColumnDelimiter>
<TextEncapsulator />
<VariableColumn>
<Name>BUKRS</Name>
<Description>Company Code</Description>
<AlphaNumeric />
<MaxLength>4</MaxLength>
</VariableColumn>
<VariableColumn>
<Name>BELNR</Name>
<Description>Accounting Document Number</Description>
<AlphaNumeric />
<MaxLength>10</MaxLength>
</VariableColumn>
<VariableColumn>
<Name>BLDAT</Name>
<Description>Document Date in Document</Description>
<Date>
<Format>YYYYMMDD</Format>
</Date>
</VariableColumn>
<VariableColumn>
<Name>BUDAT</Name>
<Description>Posting Date in the Document</Description>
<Date>
<Format>YYYYMMDD</Format>
</Date>
</VariableColumn>
<VariableColumn>
<Name>CPUTM</Name>
<Description>Time of Entry</Description>
<AlphaNumeric />
<MaxLength>6</MaxLength>
<Map>
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<From>HH :MM</From>
<To>HH:MM</To>
</Map>
</VariableColumn>
<VariableColumn>
<Name>CPUTM1</Name>
<Description>Time of Entry</Description>
<AlphaNumeric />
<MaxLength>7</MaxLength>
<Map>
<From>HH:MMTT</From>
<TOo>HH:MMTT</To>
</Map>
</VariableColumn>
<VariableColumn>
<Name>CPUTM2</Name>
<Description>Time of Entry</Description>
<AlphaNumeric />
<MaxLength>9</MaxLength>
<Map>
<From>HH:MM:SSTT</From>
<TO>HH:MM:SSTT</To>
</Map>
</VariableColumn>
<VariableColumn>
<Name>CPUTM3</Name>
<Description>Time of Entry</Description>
<AlphaNumeric />
<MaxLength>6</MaxLength>
<Map>
<From>HHMM< /From>
<To>HHMM< /To>
</Map>
</VariableColumn>
<VariableColumn>
<Name>CPUTM4< /Name>
<Description>Time of Entry</Description>
<AlphaNumeric />
<MaxLength>7</MaxLength>
<Map>
<From>HHMMTT</From>
<To>HHMMTT</To>
</Map>
</VariableColumn>
<VariableColumn>
<Name>CPUTM5</Name>
<Description>Time of Entry</Description>
<AlphaNumeric />
<MaxLength>9</MaxLength>
<Map>
<From>HHMMSS</From>
<To>HHMMSS</To>
</Map>
</VariableColumn>
<VariableColumn>
<Name>CPUTM6</Name>
<Description>Time of Entry</Description>
<AlphaNumeric />
<MaxLength>9</MaxLength>
<Map>
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<From>HHMMSSTT</From>
<TO>HHMMSSTT</To>
</Map>
</VariableColumn>
<VariableColumn>
<Name>CPUTM7</Name>
<Description>Time of Entry</Description>
<AlphaNumeric />
<MaxLength>9</MaxLength>
<Map>
<From>HH:MM:SS</From>
<TO>HH:MM:SS</To>
</Map>
</VariableColumn>
<VariableColumn>
<Name>CPUTM8</Name>
<Description>Time of Entry</Description>
<AlphaNumeric />
<MaxLength>10</MaxLength>

<Map>
<From>HHMMSS</From>
<To>HHMMSS</To>
</Map>
</VariableColumn>
</VariablelLength>
</Table>
</Media>
</DataSet>

Abbildung 17: Beispiel 4 — Datei index.xml mit Datentyp Zeit
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Haufig gestellte Fragen

Mussen wir die Daten im XML-Format liefern?
Nein. Nur die Beschreibung der Daten (Datei index.xml) ist im XML-Format. Die
Nutzdaten sind im FixedLength- oder VariableLength-Format.

Kann lhr System mit Daten in DOS/Unix/Mac-Formaten (Zeilentrenner) umgehen?
Ja, denn die Zeilentrenner kdnnen explizit angegeben werden.

Wie sind negative Zahlen darzustellen (vor/hinter der Zahl, Leerzeichen zwischen
Vorzeichen und Zahl erlaubt)?

Negativen Zahlen ist ein Minuszeichen ohne Leerstelle vor- oder nachzustellen (z. B.
»-1782,90“ oder ,1782,90-%).

Wenn eine uberlassene Datei zu groB fur einen Datentrager ist, kann sie dann auf
mehrere Datentréager gesplittet werden?

Der Beschreibungsstandard sieht ein Splitten einer Datei nicht vor. In diesem Fall kdnnen
Sie aber die Daten komprimieren oder ein Speichermedium mit gréRerer Kapazitat (z. B.
DVD) wahlen.

Welchen XML-Parser verwenden Sie?
Wir verwenden Xerces (https://xerces.apache.org/xerces-c/).

Ist es ein Fehler, wenn ForeignKey eine Tabelle referenziert, die nicht im DataSet
enthalten ist, oder wiirde der ForeignKey dann ignoriert werden?

Die Beschreibung der Verlinkungen muss mit den gelieferten Daten lbereinstimmen,
andernfalls ist Inre Datentrégeruberlassung nicht konsistent. Der Import-Prozess weist
den Prufer auf die Inkonsistenz hin.

Was passiert, wenn in der Datei index.xml eine Tabelle beschrieben wird, die aber
anschlieBend nicht vorhanden ist?

Die Beschreibung der Dateien muss mit den gelieferten Dateien Ubereinstimmen,
andernfalls ist lhre Datentragertiberlassung nicht konsistent. Der Import-Prozess weist
den Prifer auf die Inkonsistenz hin.
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¢ Sind Commands zwingend erforderlich? Stellen Sie flir Commands
Umgebungsvariablen zur Verfiigung?
Commands sind nicht zwingend erforderlich. Wenn eine BAT- oder CMD-Datei
aufgerufen wird, stehen die Ublichen Betriebssystem-Umgebungsvariablen zur
Verfugung. Der Import-Prozess setzt selbst keine Umgebungsvariablen.

¢ Wie kann abschlieRend geprift werden, ob die Daten des
Datentragers/Datenpakets von lhrem System eingelesen werden kénnen?
Die sichere Variante der Prifung ist der Import mit IDEA fir GDPdU/GoBD (IDEA +
SmartX). SmartV hilft Innen, die Beschreibungsstandard-Konformitat der Datei index.xml
und der zu importierenden Daten zu Uberprifen.

Eine einfache Moglichkeit, die XML-Datei auf ihre syntaktische Korrektheit zu testen, ist,
sie mit einem XML-fahigen Browser zu 6ffnen.

e Da ich mit XML-Standards nicht vertraut bin, ist mir nicht klar, wie ich die Dateien
index.xml und gdpdu.dtd konkret aufzubauen habe. Ich habe Ihnen eine
VariableLength-Datei zugeschickt; konnen Sie mir die korrespondierende XML-
bzw. DTD-Datei erstellen?

Sie sollten sich Grundkenntnisse in XML aneignen, die DTD-Datei mussen (durfen!) Sie
nicht modifizieren.

Die Beschreibung der Daten (in der Datei index.xml) sollte immer von der Stelle aus
geschehen, die die Datenhoheit besitzt, also vom Softwarehersteller oder
steuerpflichtigen Unternehmen.

Audicon unterstiitzt Sie bei der Uberpriifung, ob die Datentrageriiberlassung mit dem
Beschreibungsstandard Ubereinstimmt, und bei der Erstellung der Datei index.xml (siehe
https://www.caseware.net/consulting/dienstleistungspakete/).

¢ In einigen Pressemitteilungen werden auBer VariableLength und FixedLength noch
zahlreiche weitere Dateiformate genannt. Welche Formate sind fiir die
Datentrageriiberlassung relevant?
Die in einigen Artikeln genannten Dateiformate beziehen sich auf die originaren Import-
Mdglichkeiten der Software IDEA.
Der Beschreibungsstandard ist aber produktunabhangig und unterstitzt in der aktuellen
Version nur die beiden allgemeingtltigen Formate VariableLength und FixedLength.

e Muss die Datei gdpdu-01-08-2002.dtd mit auf dem Datentrager gespeichert
werden?
Ja. Ein Datentrager, der zur Datentrageriberlassung dient, muss die Datei gdpdu-01-08-
2002.dtd, die Datei index.xml und alle Nutzdaten (z. B. T1.CSV, T2.CSV, T3.CSV,
T4.ASC) enthalten.
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¢ In einer VariableLength-Datei sind im ersten Datensatz die Feldnamen gespeichert.
Wie kann man den ersten Satz Uiberlesen?
Verwenden Sie die Range-Angabe im Table-Element:

<Table>
<Range>
<From>2</From>
</Range>
<URL>Region.csv</URL>
<VariableLength>
<VariablePrimaryKey>
<Name>Regionld</Name>
<AlphaNumeric/>
</VariablePrimaryKey>
<VariableColumn>
<Name>Description</Name>
<AlphaNumeric/>
</VariableColumn>
</VariableLength>
</Table>

Abbildung 18: Range-Angabe

o Wird durch die Angabe eines Zeichensatzes, z. B. UTF7 oder Macintosh, die
Angabe des Zeilenbegrenzers automatisch ubersteuert?
Nein. Nur die explizite Angabe des Zeilenbegrenzers (RecordDelimiter) Ubersteuert den
Vorgabewert (CRLF).
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Synopse Beschreibungsstandard Version 1.0 und Version 1.1

Umbenennungen sind blau gekennzeichnet, neue oder geléschte Elemente rot.

Version 1.0 vom 10. Mai 2002 (6.6.2002)

Version 1.1 vom 1. August 2002

<?xml version="1.0" encoding="UTF-8"?>
<!--Versions available:

1.0 (May-10-2002)

-—>

<!-- Start Simple Types -->

<!-- Supplementary Vocabulary -->
<!ELEMENT Version (#PCDATA)>
<!ELEMENT Location (#PCDATA)>
<!ELEMENT Comment (#PCDATA) >
<!ELEMENT Length (#PCDATA)>
<!ELEMENT References (#PCDATA)>
<!ELEMENT From (#PCDATA)>
<!ELEMENT To (#PCDATA)>

<!-- Specifies which character
CSV text column -->

(i1f any)

<!ELEMENT TextEncapsulator (#PCDATA)>

the decimal symbol. -->

encapsulates a

<!-- Specifies how many digits appear to the right of

<?xml version="1.0" encoding="UTF-8"?>
<!--Versions available:

1.1 (August-01-2002)

-—>

<!-- Start Simple Types -->

<!-- Supplementary Vocabulary -->
<!ELEMENT Version (#PCDATA)>
<!ELEMENT Location (#PCDATA)>
<!ELEMENT Comment (#PCDATA) >
<!ELEMENT Length (#PCDATA)>
<!ELEMENT References (#PCDATA)>
<!ELEMENT From (#PCDATA)>
<!ELEMENT To (#PCDATA)>

<!-- Specifying a maximum length for a VariableLength column
can reduce a VariableLength tables' import time.

If MaxLength is not specified then we parse URL to determine
the MaxLength for each column.

* Only applies to VariablelLength tables. -->

<!ELEMENT MaxLength (#PCDATA)>

<!-- Specifies which character (if any)
VariableLength AlphaNumeric column.
Doublequote is the default TextEncapsulator "

encapsulates a

* Only applies to Variablelength tables. (Optional) -
>
<!ELEMENT TextEncapsulator (#PCDATA)>
<!-- Specifies how many digits appear to the right of the

decimal symbol.
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CAUTION:
Results are undefined when importing numeric data with
greater Accuracy than the Accuracy defined in index.xml

For example trying to import the value 1000,25 with an

accuracy of 0 might result in 1000 or an error. This
behavior is specific to the implementation.
Zero is the default Accuracy '0O' (Optional)
-—>
<!ELEMENT Accuracy (#PCDATA)> <!ELEMENT Accuracy (#PCDATA)>
<!-- The decimal place is not always stored with <!-- The decimal place is not always stored with numbers. If
numbers. If each number is supposed to have decimal each number is supposed to have decimal places use
places use ImpliedAccuracy --> ImpliedAccuracy -->
<!ELEMENT ImpliedAccuracy (#PCDATA)> <!ELEMENT ImpliedAccuracy (#PCDATA)>
<!-- The first line in CSV URL contains column headers.
A value of False is interpreted if the element is
missing. Any columns specified in the XML file take
precedence over the file. This lets you override some
columns in the file and leave the others as they are.
-=>
<!ELEMENT NamesFirstRow EMPTY>
<!-- Enables you to change how gdpdu displays dates. <!-- Enables you to change how gdpdu displays dates.
The default is implementation dependant. --> DD.MM.YYYY is the default Format -->
<!ELEMENT Format (#PCDATA)> <!ELEMENT Format (#PCDATA)>
<!-- Specifies the symbol that indicates decimal values. | <!-- Specifies the symbol that indicates decimal values.
The default is implementation dependant. Comma is the default DecimalSymbol. ','
Specified once per Table. --> Specified once per Table. -->
<!ELEMENT DecimalSymbol (#PCDATA) > <!ELEMENT DecimalSymbol (#PCDATA) >
<!-- Specifies the symbol that groups the digits in <!-- Specifies the symbol that groups the digits in large
large numbers. numbers. Dot is the default DigitGroupingSymbol or
The default is implementation dependant. ThousandsSeperator. '.'
Specified once per Table --> Specified once per Table -->
<!ELEMENT DigitGroupingSymbol (#PCDATA)> <!ELEMENT DigitGroupingSymbol (#PCDATA) >
<!-- Command(s) are executed in the following manner <!-- Command(s) are executed in the following manner
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* before the import process
* after the import process
* before a Media is imported
* after a Media is imported
-—>

<!ELEMENT Command (#PCDATA)>
The root path is the path of Media

The following are all invalid
* http://www.somewhere.com/data/Accounts.csv

* ftp://ftp.somewhere.com/data/Accounts.csv
*

The following is wvalid.
* file://Accounts.csv

<!ELEMENT URL (#PCDATA) >

<!-- Textual description of specified element -->
<!ELEMENT Description (#PCDATA)>

<!-- The logical names of specified element -->

<!ELEMENT Name (#PCDATA) >

<!-- Y2K Window Any year before Epoch is 2000+
Default value 50. -->

<!-- Only the file protocol is supported at this time.

* before the import process
* after the import process
* before a Media is imported
* after a Media is imported
-—>

<!ELEMENT Command (#PCDATA) >

<!-- Only the file protocol is supported at this time.

* The standard uses relative URLs.

Absolute URLs are not allowed. The following are all
invalid:
* http://www.somewhere.com/data/Accounts.dat
* ftp://ftp.somewhere.com/data/Accounts.dat
* file://localhost/Accounts.dat
* file:///Accounts.dat

The following are valid examples
* Accounts.dat
* data/Accounts.dat
* data/january/Accounts.dat
* _./Accounts.dat
-—>

<!ELEMENT URL (#PCDATA) >

<!-- Textual description of specified element (Optional) -->
<!ELEMENT Description (#PCDATA) >

<!-- The logical name of specified element.
Sometimes referred to business name.

If missing, URL will be used in place of Name. -->
<!ELEMENT Name (#PCDATA) >
<!-- Y2K Window Any year before Epoch is 2000+
Default value 30. -->
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<!ELEMENT Epoch (#PCDATA)>
<!-- Specifies the symbol that seperates CSV columns or
ASCITIFixedLength records. -->

<!ELEMENT Delimiter (#PCDATA)>

<!-- The number of bytes skipped before reading of URL
commences. —-->

<!ELEMENT SkipNumBytes (#PCDATA)>

<!-- End Simple Types -->
<!-- Start Complex Types -->
<!-- Self-explanetory -->

<!ELEMENT Range (From, (To | Length)?)>

<!-- The document element -->
<!ELEMENT DataSet (Version, DataSupplier?,
Media+, Command*) >

Command*,

<!-- Supported datatypes
AlphaNumeric is the default datatype when a
datatype is not defined. -->
<!ELEMENT AlphaNumeric EMPTY>
<!ELEMENT Date (Format?, Epoch?)>

<!ELEMENT Numeric ((ImpliedAccuracy | Accuracy)?)>

<!ELEMENT Epoch (#PCDATA)>

<!-- Element(s) that separate columns or records.
Semicolon is the default ColumnDelimiter. ';'
CRLF or &#13;&#10; is the default RecordDelimiter. -->
<!ELEMENT ColumnDelimiter (#PCDATA)>
<!ELEMENT RecordDelimiter (#PCDATA)>

<!-- The number of bytes skipped before reading of URL
commences. Zero is the default when not specified. '0' -->
<!ELEMENT SkipNumBytes (#PCDATA)>

<!-- End Simple Types -->

<!-- Start Complex Types -->

<!-- Self-explanatory -->

Length) ?) >
Length))>

<!ELEMENT Range (From, (To |
<!ELEMENT FixedRange (From, (To |

<!-- The document element -->
<!ELEMENT DataSet (Version, DataSupplier?,
Command*) >

Command*, Media+,

<!-- Supported datatypes (mandatory) -->

<!ELEMENT AlphaNumeric EMPTY>
<!ELEMENT Date (Format?)>

<!ELEMENT Numeric ((ImpliedAccuracy | Accuracy)?)>

<!-- Supported codepages:

Be careful to explicitly define RecordDelimiter when using a
non-default codepage.

ANSI is the default codepage when not specified -->
<!ELEMENT ANSI EMPTY>

<!'ELEMENT Macintosh EMPTY>

<!'ELEMENT OEM EMPTY>

<!'ELEMENT UTF16 EMPTY>

<!ELEMENT UTF7 EMPTY>

<!ELEMENT UTF8 EMPTY>
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<!-- Supported file formats -->

<!ELEMENT ASCIIFixedLength ((Length | Delimiter)?,
((FixedPrimaryKey+, FixedColumn*) | (FixedPrimaryKey¥*,
FixedColumn+)), ForeignKey*)>

<!ELEMENT FixedColumn (Name, Description?, (Numeric |
AlphaNumeric | Date)?, Map*, Range)>

<!ELEMENT FixedPrimaryKey (Name, Description?, (Numeric
| AlphaNumeric | Date)?, Map*, Range)>

<!ELEMENT CSV (NamesFirstRow?, Delimiter?,
TextEncapsulator?, ((PrimaryKey+, Column*) |
(PrimaryKey*, Column+))?, ForeignKey¥*)>

<!ELEMENT Column (Name, Description?, (Numeric |
AlphaNumeric | Date)?, Map*)>

<!ELEMENT PrimaryKey (Name, Description?, (Numeric |
AlphaNumeric | Date)?, Map*)>

<!-- Description of the entity supplying the data.
(Optional) -->

<!ELEMENT DataSupplier (Name, Location, Comment)>

<!-- The first Media will contain index.xml. Importing

will process each media listed -->

<!ELEMENT Media (Name, Command*, Table+, Command*)>

<!-- Elements common to ASCCIIFIXEDLENGTH & CSV are
propagated to Table.
CSV is the default format if none is specified. -->

<!ELEMENT Table (URL, Name?, Description?, Validity?,
(DecimalSymbol, DigitGroupingSymbol)?, SkipNumBytes?,
Range?, (CSV | ASCIIFixedLength)?)>

<!-- ForeignKeys denote joins and relationships between
tables.

Not specifying ForeignKeys prevent joins from
occurring. -->

<!-- Supported file formats: FixedLength, VariableLength -->
<!ELEMENT FixedLength ((Length | RecordDelimiter)?,
((FixedPrimaryKey+, FixedColumn*) | (FixedColumn+)),
ForeignKey¥*) >

<!ELEMENT FixedColumn (Name, Description?,
AlphaNumeric | Date), Map*, FixedRange)>
<!ELEMENT FixedPrimaryKey (Name, Description?,
AlphaNumeric | Date), Map*, FixedRange)>
<!ELEMENT VariableLength (ColumnDelimiter?, RecordDelimiter?,
TextEncapsulator?, ((VariablePrimaryKey+, VariableColumn*) |
(VariableColumn+) ) , ForeignKey*)>

<!ELEMENT VariableColumn (Name, Description?,
(AlphaNumeric, MaxLength?) | Date), Map*)>
<!'ELEMENT VariablePrimaryKey (Name, Description?,
(AlphaNumeric, MaxLength?) | Date), Map*)>

(Numeric |

(Numeric |

(Numeric |

(Numeric |

<!-- Description of the entity supplying the data.
-—>
<!ELEMENT DataSupplier

(Optional)

(Name, Location, Comment)>

<!-- The first Media will contain index.xml.
process each media listed -->
<!ELEMENT Media (Name, Command*,

Importing will

Table+, Command*)>

<!-- Elements common to FixedLength & VariableLength are
propagated to Table. -->

<!'ELEMENT Table (URL, Name?, Description?, Validity?, (ANSI |
Macintosh | OEM | UTF16 | UTF7 | UTF8)?, (DecimalSymbol,
DigitGroupingSymbol) ?, SkipNumBytes?, Range?, Epoch?,
(VariableLength | FixedLength))>

<!-- ForeignKeys denote joins or relationships between
tables. To successfully join two tables make sure both the
PrimaryKey and the referenced column (foreignkey) are of the
same datatype.

Results are undefined when joining two tables with different
key datatypes. Most likely an error will occur. -->
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<!ELEMENT ForeignKey (Name+, References)>

<!-- Maps data from 'From' to 'To'
ie. From To
True 1
True -1
False 0

A map is basically an associative container.
Take caution that 'From' is of the same type
as the column datatype.

<!ELEMENT Map (Description?, From, To)>

<!-- Documentation for table validity. -->
<!ELEMENT Validity (Range, Format?)>

<!-- End Complex Types —-->

<!ELEMENT ForeignKey (Name+, References)>

<!-- Maps AlphaNumeric columns from 'From' to 'To'
ie. From To
True 1
True -1
False 0

Basically, a map is an associative container.

The standard implementation only supports
AlphaNumeric datatypes. The following
conversions are NOT supported.

Numeric -> AlphaNumeric
Date -> AlphaNumeric
AplhaNumeric -> Date
AlphaNumeric -> Numeric

-—>

<!ELEMENT Map (Description?, From, To)>

<!-- Documentation for table validity. -->
<!ELEMENT Validity (Range, Format?)>

<!-- End Complex Types -->

Tabelle 51: Gegendiiberstellung Beschreibungsstandard Version 1.0 und 1.1
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Synopse Beschreibungsstandard Version 1.1 und Version 1.6

Umbenennungen sind blau gekennzeichnet, neue oder geléschte Elemente rot.

Version 1.1 vom 1. August 2002

Version 1.6 vom 1. Marz 2019

<?xml version="1.0" encoding="UTF-8"7?>
<!--Versions available:

1.1 (August-01-2002)

-—>

<?xml version="1.0" encoding="UTF-8"?>
<!--Versions available:
1.1 (August-01-2002)

1.2 (June-01-2003)
New Element Alias

1.3 (November-01-2003)
New Element Extension

1.4 (May-01-2004)
New Element AcceptNoTables
<Table> is now optional

1.5 (September-01-2004)
Updated the ForeignKey and Alias elements so they allow
multiple Alias elements per ForeignKey. This allows one
to use alias elements for a Composite key.

Example:

<ForeignKey>
<Name>Order</Name>
<Name>Customer</Name>
<References>Orders</References>
<Alias>
<From>Order</From>
<To>OrderId</To>
</Alias>
<Alias>
<From>Customer</From>

Beschreibungsstandard GDPdU/GoBD

59




~ caseware

Version 1.1 vom 1. August 2002

Version 1.6 vom 1. Marz 2019

<!-- Start Simple Types -->

<!-- Supplementary Vocabulary -->
<!ELEMENT Version (#PCDATA)>
<!ELEMENT Location (#PCDATA)>
<!ELEMENT Comment (#PCDATA)>
<!ELEMENT Length (#PCDATA)>
<!ELEMENT References (#PCDATA)>
<!ELEMENT From (#PCDATA)>
<!ELEMENT To (#PCDATA)>

<To>CustomerId</To>
</Alias>

1.6 (March-03-2019)

Updated the Map and From/To elements descriptions so
they allow importing an Alphanumeric column as Time
column.

This allows defining that an Alphanumeric column
contains data of type Time and allows you to specify which
is the time format used.

Example:

<Map>
<From>HHMMSS</From>
<To>HHMMSS</To>
</Map>
-—>
<!-- Start Simple Types -->

<!-- Supplementary Vocabulary -->
<!ELEMENT Version (#PCDATA)>
<!ELEMENT Location (#PCDATA)>
<!ELEMENT Comment (#PCDATA) >
<!ELEMENT Length (#PCDATA)>
<!ELEMENT References (#PCDATA)>
<!ELEMENT From (#PCDATA)>
<!ELEMENT To (#PCDATA)>

<!-- Sometimes, it is desirable to have a <Media> with no
tables.

Example:
An extension might provide metadata that describes all
tax-relevant data.

This option is turned off by default. -->
<!'ELEMENT AcceptNoTables (#PCDATA)>
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<!-- Specifying a maximum length for a VariableLength
column can reduce a Variablelength tables' import time. If
MaxLength is not specified then we parse URL to determine
the MaxLength for each column.

* Only applies to VariableLength tables. -->
<!ELEMENT MaxLength (#PCDATA)>
<!-- Specifies which character (if any) encapsulates a

VariableLength AlphaNumeric column.
Doublequote is the default TextEncapsulator "

<!-- Use Alias to reference columns with different names
in a ForeignKey element. These Alias elements are
optional.

The following rules apply to the Alias element:
- One Alias can be used per ForeignKey.
- Alias elements can appear in any order.

Example:
Table Orders has a primary key OrderId
Table Accounts has a foreign key Order.

You can use the Alias element to specify Order
references OrderId.

<ForeignKey>
<Name>Order</Name>
<Name>Customer</Name>
<References>0Orders</References>
<Alias>
<From>Order</From>
<To>OrderId</To>
</Alias>
</ForeignKey> -->
<!ELEMENT Alias (From, To)>

<!-- Specifying a maximum length for a VariableLength
column can reduce a Variablelength tables' import time. If
MaxLength is not specified then we parse URL to determine
the MaxLength for each column.

* Only applies to VariablelLength tables. -->
<!ELEMENT MaxLength (#PCDATA)>
<!-- Specifies which character (if any) encapsulates a

VariableLength AlphaNumeric column.
Doublequote is the default TextEncapsulator "

Beschreibungsstandard GDPdU/GoBD

61




~ caseware.

Version 1.1 vom 1. August 2002

Version 1.6 vom 1. Marz 2019

* Only applies to VariablelLength tables. (Optional)
-—>
<!ELEMENT TextEncapsulator (#PCDATA)>
<!-- Specifies how many digits appear to the right of the

decimal symbol.

CAUTION: Results are undefined when importing
numeric data with greater Accuracy than the Accuracy
defined in index.xml

For example trying to import the wvalue 1000,25 with an
accuracy of 0 might result in 1000 or an error. This
behavior is specific to the implementation.

Zero is the default Accuracy '0O' (Optional)
-—>
<!ELEMENT Accuracy (#PCDATA)>
<!-- The decimal place is not always stored with numbers.

If each number is supposed to have decimal places use
ImpliedAccuracy —-->

<!ELEMENT ImpliedAccuracy (#PCDATA)>
<!-- Enables you to change how GDPdU displays dates.

DD.MM.YYYY is the default Format -->
<!ELEMENT Format (#PCDATA)>

<!-- Specifies the symbol that indicates decimal values.
Comma is the default DecimalSymbol. ','
Specified once per Table. -->
<!ELEMENT DecimalSymbol (#PCDATA)>
<!-- Specifies the symbol that groups the digits in large

numbers.

* Only applies to VariableLength tables. (Optional)
-—>
<!ELEMENT TextEncapsulator (#PCDATA)>
<!-- Specifies how many digits appear to the right of the

decimal symbol.

CAUTION: Results are undefined when importing
numeric data with greater Accuracy than the Accuracy
defined in index.xml

For example trying to import the wvalue 1000,25 with an
accuracy of 0 might result in 1000 or an error. This
behavior is specific to the implementation.

Zero 1is the default Accuracy '0O' (Optional)
-——>
<!ELEMENT Accuracy (#PCDATA)>
<!-- The decimal place is not always stored with numbers.

If each number is supposed to have decimal places use
ImpliedAccuracy —-->

<!ELEMENT ImpliedAccuracy (#PCDATA)>

<!-- Enables you to change how GDPdU displays dates.
DD.MM.YYYY is the default Format -->

<!ELEMENT Format (#PCDATA)>

<!-- Specifies the symbol that indicates decimal values.

Comma is the default DecimalSymbol. ','

Specified once per Table. -->

<!ELEMENT DecimalSymbol (#PCDATA)>

<!-- Specifies the symbol that groups the digits in large

numbers.
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Dot is the default DigitGroupingSymbol or
ThousandsSeperator. '.'
Specified once per Table -->
<!ELEMENT DigitGroupingSymbol (#PCDATA)>
<!-- Command(s) are executed in the following manner
* before the import process
* after the import process
* before a Media is imported
* after a Media is imported
-——>
<!ELEMENT Command (#PCDATA) >
<!-- Only the file protocol is supported at this time.
* The standard uses relative URLs.

Absolute URLs are not allowed.
all invalid:
* http://www.somewhere.com/data/Accounts.dat
* ftp://ftp.somewhere.com/data/Accounts.dat
* file://localhost/Accounts.dat
* file:///Accounts.dat

The following are

The following are valid examples
* Accounts.dat
* data/Accounts.dat
* data/january/Accounts.dat
* . ./Accounts.dat
-—>
<!ELEMENT URL (#PCDATA)>
<!-- Textual description of specified element
->

(Optional)

<!ELEMENT Description (#PCDATA)>
<!-- The logical name of specified element.

Dot is the default DigitGroupingSymbol or
ThousandsSeperator. '.'
Specified once per Table -->
<!ELEMENT DigitGroupingSymbol (#PCDATA)>
<!-- Command(s) are executed in the following manner
* before the import process
* after the import process
* before a Media is imported
* after a Media is imported
-——>
<!ELEMENT Command (#PCDATA) >
<!-- Only the file protocol is supported at this time.
* The standard uses relative URLs.

Absolute URLs are not allowed. The following are
all invalid:
* http://www.somewhere.com/data/Accounts.dat
* ftp://ftp.somewhere.com/data/Accounts.dat
* file://localhost/Accounts.dat
* file:///Accounts.dat

The following are valid examples
* Accounts.dat
* data/Accounts.dat
* data/january/Accounts.dat
* . ./Accounts.dat
-—>
<!ELEMENT URL (#PCDATA)>
<!-- Textual description of specified element
->

(Optional)

<!ELEMENT Description (#PCDATA) >
<!-- The logical name of specified element.
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Sometimes referred to business name.

If missing, URL will be used in place of Name. -->
<!ELEMENT Name (#PCDATA)>

<!-- Y2K Window Any year before Epoch is 2000+
Default value 30. -->
<!ELEMENT Epoch (#PCDATA)>

<!-- Element (s) that separate columns or records.
Semicolon is the default ColumnDelimiter. ';'
CRLF or &#13;&#10; is the default RecordDelimiter.
-—>
<!ELEMENT ColumnDelimiter (#PCDATA)>
<!ELEMENT RecordDelimiter (#PCDATA) >

<!-- The number of bytes skipped before reading of URL
commences.
Zero is the default when not specified. '0'
-—>
<!ELEMENT SkipNumBytes (#PCDATA)>

<!-- End Simple Types -->
<!-- Start Complex Types -->

Sometimes referred to business name.

If missing, URL will be used in place of Name. -->
<!ELEMENT Name (#PCDATA)>

<!-- Y2K Window Any year before Epoch is 2000+
Default value 30. -->
<!ELEMENT Epoch (#PCDATA)>

<!-- Element (s) that separate columns or records.
Semicolon is the default ColumnDelimiter. ';'
CRLF or &#13;&#10; is the default RecordDelimiter.
-——>
<!ELEMENT ColumnDelimiter (#PCDATA)>
<!ELEMENT RecordDelimiter (#PCDATA)>

<!-- The number of bytes skipped before reading of URL
commences.
Zero is the default when not specified. '0'
-—>
<!ELEMENT SkipNumBytes (#PCDATA)>

<!-- End Simple Types -->
<!-- Start Complex Types -->
<!-- Use Extension when you want to add application

specific functionality to the existing standard.

Name - the extension name or identifier.

URL - the supplementary .xml file that corresponds
to the extension.

An application that extends the standard should scan
the Dataset element for the presence of zero or more
Extension elements. The application can use the Name
element to identify the extension.
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<!-- Self-explanatory -->
<!ELEMENT Range (From, (To | Length)?)>
<!ELEMENT FixedRange (From, (To | Length))>

<!-- The document element -->
<!ELEMENT DataSet (Version, DataSupplier?, Command¥*,
Media+, Command*) >

<!-- Supported datatypes (mandatory) -->

<!ELEMENT AlphaNumeric EMPTY>

<!ELEMENT Date (Format?)>

<!ELEMENT Numeric ((ImpliedAccuracy | Accuracy)?)>

<!-- Supported codepages:
Be careful to explicitly define RecordDelimiter when
using a non-default codepage.
ANSI is the default codepage when not specified -->
<!ELEMENT ANSI EMPTY>
<!ELEMENT Macintosh EMPTY>
<!ELEMENT OEM EMPTY>
<!ELEMENT UTFl6 EMPTY>
<!ELEMENT UTF7 EMPTY>
<!ELEMENT UTF8 EMPTY>

<!-- Supported file formats:
FixedLength
VariableLength -->

When choosing a name for your extension, do not
choose a common name. This will reduce undefined results
for name conflicts.

It is possible that future extensions will be
ratified as mandatory to meet GDPAU guidelines. -->
<!'ELEMENT Extension (Name, URL)>

<!-- Self-explanatory -->
<!ELEMENT Range (From, (To | Length)?)>
<!ELEMENT FixedRange (From, (To | Length))>

<!-- The document element -->
<!ELEMENT DataSet (Extension*, Version, DataSupplier?,
Command*, Media+, Command*)>

<!-- Supported datatypes (mandatory) -->

<!ELEMENT AlphaNumeric EMPTY>

<!ELEMENT Date (Format?)>

<!ELEMENT Numeric ((ImpliedAccuracy | Accuracy)?)>

<!-- Supported codepages:
Be careful to explicitly define RecordDelimiter when
using a non-default codepage.
ANSI is the default codepage when not specified -->
<!ELEMENT ANSI EMPTY>
<!ELEMENT Macintosh EMPTY>
<!ELEMENT OEM EMPTY>
<!ELEMENT UTFl16 EMPTY>
<!ELEMENT UTF7 EMPTY>
<!ELEMENT UTF8 EMPTY>

<!-- Supported file formats:
FixedLength
VariableLength -->
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<!ELEMENT FixedLength ((Length |
((FixedPrimaryKey+, FixedColumn¥*) |
ForeignKey*) >

RecordDelimiter) ?,
(FixedColumn+) ),

<!ELEMENT FixedColumn
AlphaNumeric | Date),

(Name, (Numeric |

Map*,

Description?,
FixedRange) >
<!ELEMENT FixedPrimaryKey (Name, Description?, (Numeric |
AlphaNumeric | Date), Map*, FixedRange)>

<!ELEMENT VariablelLength (ColumnDelimiter?,
RecordDelimiter?, TextEncapsulator?,
((VariablePrimaryKey+, VariableColumn*) |
(VariableColumn+) ), ForeignKey*)>

<!ELEMENT VariableColumn (Name, Description?,
(AlphaNumeric, MaxLength?) | Date), Map*)>

(Numeric |

<!ELEMENT VariablePrimaryKey (Name, Description?, (Numeric

| (AlphaNumeric, MaxLength?) | Date), Map*)>

<!-- Description of the entity supplying the data.
(Optional) -->

<!ELEMENT DataSupplier (Name, Location, Comment)>
<!-- The first Media will contain index.xml.

will process each media listed -->

Importing

<!ELEMENT Media (Name, Command*, Table+, Command*)>

<!-- Elements common to FixedLength & VariableLength are
propagated to Table. -->

<!ELEMENT Table (URL, Name?, Description?, Validity?,
(ANSI | Macintosh | OEM | UTFl6 | UTF7 | UTFS8)?,
(DecimalSymbol, DigitGroupingSymbol)?, SkipNumBytes?,
Range?, Epoch?, (VariableLength | FixedLength))>

<!ELEMENT FixedLength ((Length |
((FixedPrimaryKey+, FixedColumn¥*) |
ForeignKey*) >

RecordDelimiter) ?,
(FixedColumn+) ),

<!ELEMENT FixedColumn
AlphaNumeric | Date),

(Name, (Numeric |

Map*,

Description?,
FixedRange) >
<!ELEMENT FixedPrimaryKey (Name, (Numeric |
AlphaNumeric | Date), Map*,

Description?,
FixedRange) >

<!ELEMENT VariableLength (ColumnDelimiter?,
RecordDelimiter?, TextEncapsulator?,
((VariablePrimaryKey+, VariableColumn*) |
(VariableColumn+) ), ForeignKey¥*)>

<!ELEMENT VariableColumn (Name, Description?, (Numeric |
(AlphaNumeric, MaxLength?) | Date), Map*)>
<!ELEMENT VariablePrimaryKey (Name, Description?, (Numeric
| (AlphaNumeric, MaxLength?) | Date), Map¥*)>

<!-- Description of the entity supplying the data.
(Optional) -->
<!ELEMENT DataSupplier Comment) >

(Name, Location,

<!-- The first Media will contain index.xml. Importing

will process each media listed -->

<!ELEMENT Media (Name, Command*, Table*, Command¥*,
AcceptNoTables?) >

<!-- Elements common to FixedLength & VariableLength are
propagated to Table. -->

<!ELEMENT Table (URL, Name?, Description?, Validity?,
(ANSI | Macintosh | OEM | UTFl16 | UTF7 | UTES)?,
(DecimalSymbol, DigitGroupingSymbol)?, SkipNumBytes?,
Range?, Epoch?, (VariableLength | FixedLength))>
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<!-- ForeignKeys denote joins or relationships between
tables.

To successfully join two tables make sure both the
PrimaryKey and the referenced column (foreignkey) are of
the same datatype.

Results are undefined when joining two tables with
different key datatypes. Most likely an error will occur.
-—>
<!ELEMENT ForeignKey (Name+, References)>

<!-- Maps AlphaNumeric columns from 'From' to 'To'
ie. From To
True 1
True -1
False 0

Basically, a map is an associative container.

The standard implementation only supports
AlphaNumeric datatypes. The following
conversions are NOT supported.

Numeric -> AlphaNumeric
Date -> AlphaNumeric
AplhaNumeric -> Date
AlphaNumeric -> Numeric

<!-- ForeignKeys denote joins or relationships between
tables.

To successfully join two tables make sure both the
PrimaryKey and the referenced column (ForeignKey) are of
the same datatype.

Results are undefined when joining two tables with
different key datatypes. Most likely an error will occur.
see line 35 for information about Alias -->
<!ELEMENT ForeignKey (Name+, References, Alias*)>

<!-- Maps AlphaNumeric columns from 'From' to 'To'
ie. From To
True 1
True -1
False 0

Basically, a map is an associative container.

The standard implementation only supports
AlphaNumeric datatypes. The following
conversions are NOT supported.

Numeric -> AlphaNumeric
Date -> AlphaNumeric
AplhaNumeric -> Date
AlphaNumeric -> Numeric

In order to keep the backward compatibility and
because the Time data type was not defined yet we allow
specifying that an Alphanumeric

column contains data of type Time like:

<Map>
<From>HHMMSS</From>
<To>HHMMSS</To>
</Map>
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<!ELEMENT Map (Description?, From, To)>

<!-- Documentation for table validity. -->
<!ELEMENT Validity (Range, Format?)>

<!-- End Complex Types —-->

If the application which interprets the xml and the
target application

to import into are able to deal with time data type
this column data could

be imported as Time data type

The value of the From element has to be equal with
the value of the To

element, in order to not be interpreted as an actual
Alphanumeric data mapping

in which the intention is to replace a certain text
with a different text at

import time, and be a valid Time format.

The following formats are recognized as valid Time
formats:

HH as symbols for hours

MM as symbols for minutes

SS as symbols for seconds

TT as symbols for AM/PM

SS and TT are optional when defining the format.

A time format separator can also be supplied if
needed.

Examples of valid formats:

HHMM, HH:MM, HHMMSS, HHMMTT, HH:MMTT, HH:MM:SS,
HHMMSSTT,

HH:MM:SSTT, HHMM TT, HH:MM TT, HHMMSS TT, HH:MM:SS
TT
-—>
<!ELEMENT Map (Description?, From, To)>

<!-- Documentation for table validity. -->
<!ELEMENT Validity (Range, Format?)>

<!-- End Complex Types -->

Tabelle 52: Gegendiiberstellung Beschreibungsstandard Version 1.1 und 1.6
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